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Abstract 

 

            Modelica is an object-oriented equation based language to model complex physical systems 

containing mechanical, electrical and other types of components. It provides libraries that enable to 

simulate these systems. Many commercial and free simulation environments are available. It is 

maintained by the non-profitable organization called the “Modelica Association” containing 

members from different parts of the world. Many industries use Modelica for model based 

development. 

 

           OpenModelica is an open source object-oriented equation based language based on 

Modelica. DrModelica is a guide to learn Modelica, and it provides a detailed tutorial for Modelica 

that range from beginner to expert level. OMNotebook document provides an interactive way to 

learn DrModelica. It provides series of tutorials that help to learn to use Modelica. It provides 

dynamic way to simulate models. 

 

  OMSketch is a graphical editor to OMNotebook document. Its main aim is to provide 

shapes to OMNotebook document. The editor provides different shapes that can be drawn 

dynamically and also have properties such as colors, pen styles and brush properties. The shapes 

can be dynamically resized, translated and rotated. These operations can be performed on single 

shape and also on a group of shapes. Edit operations such as cut, copy and paste are supported. 

Keyboard shortcuts are also available to perform edit operations. The drawn shapes can be saved 

into different file formats such as png, bmp etc. These can also be open to edit and make changes. 

The OMSketch editor saves the shapes in regular graphical file formats with some information. The 

shape's properties are also saved into a file as text. Thus every saved shape from OMSketch 

contains the shape, and its coordinates and other properties. This makes it possible to edit the image 

when it is open in the editor. The main purpose of OMSketch is to embed shapes into OMNotebook 

document and also edit back from OMNotebook document to OMSketch. OMSketch is a very 

interactive and advance graphical editor for OMNotebook document.         
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Outline 

 The focus of this thesis work is on developing a graphical editor "OMSketch” a plug-

in to OMNotebook document. The editor consists of shapes that can be drawn using a mouse 

and then their different attributes can be set. Finally the shapes can be exported to 

OMNotebook document or saved to graphical file formats. 

       

Chapter 1:  

This chapter gives a brief introduction to the background information and reader 

prerequisites. The purpose behind the thesis is explained here together with an analysis study 

done in the design stages of this project. 

Chapter 2: 

This chapter discusses how to start OMSketch, draw shapes and other functionalities. 

It gives an overview of OMSketch editor.  

 

Chapter 3: 

This chapter introduces the Qt-Trolltech and its SDK’s, the important class used in 

this work.  

Chapter 4: 

This chapter gives a brief introduction to OMNotebook document and OMSketch 

application. 

Chapter 5:           

 This chapter provides the main application layout of OMSketch.  

Chapters 6: 

  This chapter discusses the types of shapes supported by OMSketch and the type of 

attributes they support and also the different actions that can be performed on them. On the 

whole it discusses in detail the implementation of the shapes.  

Chapter 7:           

  This chapter gives the file management system of this application. 
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Chapter 8: 

This chapter explains how the images are read and written and also the different 

editing operations that can be performed on the shapes.  

Chapter 9:            

 This chapter shows the results of shapes and widgets of OMSketch application. 

Conclusion 

Future work 

References 

Appendix A:  

Starting with OMNotebook document: 
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Chapter 1  Introduction 

 

1.1 Background 

               Modelica is a free object oriented equation based language to model and simulate complex 

physical systems that contain electrical, mechanical, electronic, hydraulic and many similar types of 

systems. It provides libraries for modeling components. OpenModelica is an open-source modeling 

and simulation environment based on Modelica. It is mainly designed for industrial and academic 

usage. Its main goal is to provide a free software distribution for compilation and simulation.  

DrModelica is a learning guide for Modelica together with modeling and simulations. It’s a detailed 

tour of tutorials ranging from beginners to advanced users. It provides materials, examples and 

exercises. 

      

 OMNotebook document is an interactive electronic book application. It supports interactive 

tutorial documents such as DrModelica. OMNotebook document documents contain cells and each 

cell contains different Modelica exercises and examples. The students and users can test and run the 

simulations dynamically. On the whole it’s a complete editor to learn Modelica with modeling and 

simulations. 

 

1.2 Readers Prerequisite 

          The readers reading this report should have a prior knowledge of Modelica, OpenModelica, 

DrModelica and OMNotebook document. They should also have some basic knowledge of 

graphical editors. The concepts present in the report are mainly concentrated on programming and 

use of Qt SDK. So a good knowledge of programming and Qt is required. 

 

1.3 Problem           

     OMNotebook document is an interactive electronic book application used for different 

tutorial documents. OMNotebook document helps students and users to learn tutorials in an 

interactive way. It provides interactive computations, texts and graphics. The graphic shapes can 

only be inserted into the cells as images but these images cannot be edited or changed according to 

the user need. This thesis work provides one of the solutions to this problem. 

 

1.4 Goal 

  The Aim of this thesis work is to develop an interactive paint application plug-in 

"OMSketch" for OMNotebook document.  The editor should be easy to interact with to draw the 

shapes and manage them.  The editor provides a large variety of shapes from standard ones such as 

Lines, Rectangles, Polygons and Texts, to complex ones such as arcs, arrows and line arrows etc. 

The shapes should be drawn dynamically and the user should also be able to set properties such as 

colors, pen styles, pen widths, different fill patterns.  The shapes can be dynamically resized, 
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translated and rotated. The editor should also provide an easy interactive way to save the files to 

different file formats such as png, bmp etc.  It should also open the graphical files mentioned above. 

The editor should also make it easy to cut copy and paste a shape or group of shapes. The shapes 

drawn in this editor should be open in other editors. The editor provides options to export the 

shapes to OMNotebook document and also import shapes back to editor from OMNotebook 

document to make changes. 

 

1.5 Study and Design Analysis 

           In order to implement OMSketch editor, I have looked at various aspects of understanding 

the thesis work. To achieve the thesis requirements, I have studied papers about OpenModelica, 

Understood the implementation and code of OMNotebook document. I have also studied different 

graphical editors, their GUI components, interfaces and user interactions techniques. In order to 

design the editor I used MSWord, Gimp and Inkscape as reference.  

 

In order to accomplish the thesis work two types of design techniques can be implemented. 

The first approach is similar to MSWord 
[51]

 but with some changes. A layout such as GIMP 
[52]

 can 

be implemented. In this approach, the main components are floating that is drawing area; toolbars, 

etc. can be moved independent of each other. Since OMNotebook document, document is divided 

into cells, to draw a shape at current cursor position, a key board and a menu action can be use to 

pop up the drawing area and it’s tool's. Once the shape is drawn the window is closed and the shape 

is inserted. This approach will work fine, but may be makes the users interaction cumbersome, 

because all the components are popped up in the same window.   

 

The Second approach is to open an entire new window containing all the components to 

draw and manipulate the shapes. I have followed the second procedure in developing the OMSketch 

editor. There two specific reasons to follow this technique. First, Since OMNotebook document is 

divided into cells containing exercises, it basically contains a lot of text, and it’s confusing and 

cumbersome to draw a shape in between the texts. The second reason is, a new window 

implementation gives scope to add more features to the editor. The editor is not only used for 

OMNotebook document’s own purpose but also can be using it to save outside the OMNotebook 

document. It gives a graphical editor look and feel to the users. It provides a multipurpose approach 

in drawing the shapes and manipulating them. 
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Chapter 2 Starting OMSketch 

        OMSketch starts on clicking the paint icon in OMNotebook document. A new application 

window will appear.   Figure no shows the OMSketch editor and different components present in it. 

 Figure-2 OMSketch Main Window 
 

          

By default, OMSketch starts with a new file. A new file can also be select from the file menu 

File>new option, or by clicking the file icon from “Home” tab.   

 

2.1 Shapes and Drawing Procedure 

2.1.1 Shapes 

OMSketch supports nine different types of shapes and text. All shapes and text can be select 

by clicking on the icons of the toolbar under the menu bar.  OMSketch provides Arc, Arrow, 

Ellipse, Rectangle, Rounded Rectangle, Polygon, and Poly Line, Line Arrow and Triangle shapes 

and text. 
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2.1.1.1 Rectangle Shape 

 A Rectangle shape is select by clicking the rectangle icon in the toolbar. In order to draw a 

line, the user click on drawing area keeping the left mouse button press, this point is stored as initial 

position of rectangle and moving the mouse across draws a rectangle until the left button is 

released. The released position is stored as second point of rectangle. The rectangle is drawn and 

controlled by these two points. Two handles are added at starting and ending points of the rectangle. 

 

2.1.1.2 Rounded Rectangle and Ellipse shapes 

Similar as a rectangle these two shapes are initialized by selecting the icons from the toolbar. 

The same procedure is followed as a rectangle to draw these two shapes the initial and last points 

are stored and handles are added at these two points.   

 

2.1.1.3 Poly Line 

 A poly line is select by clicking on line an icon on the toolbar. Keeping the left button press 

and clicked on drawing area, the line initial point is initialized and starts drawing, as the mouse is 

moved the size of the line dynamically increases and when the mouse is released the second point is 

initialized and new line starts from that point. This process continues until the mouse is double 

clicked. To draw a line the minimum two points are required. Handles are added at every point/edge 

of the line. 

 

2.1.1.4 Polygon 

A polygon can be selected as mentioned in above shapes. In order to draw a polygon the 

similar procedure is followed as mentioned for line. The only difference is that the polygon forms a 

closed path, when the mouse is double clicked. At least, three points are needed to form a closed 

polygon shape. Handles are added at every point of a polygon. 

 

2.1.1.5 Arc 

An arc is drawn or controlled by three points. Arc initialized by clicking the arc icon on the 

toolbar. To draw an arc, move the cursor on drawing area hold the left mouse button at desired 

position. This position is set as an initial point of arc, drag the mouse this action draws a line until 

the mouse left button released. Once the line is drawn, click on any point on-line and drag it, this 

action draws the arcs along the drag point. Three handles are shown when the arc is completely 

drawn. Using these handles the arc can be resized. 

 

2.1.1.6 Arrow and Triangle 

An arrow is drawn using seven points and a triangle with three points. These two shapes can 

be selected in the similar way like other shapes mentioned above. To draw the shapes just the 
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mouse on the drawing area, depending on shape selected (arrow or triangle) a fixed size shape is 

drawn.  Handles are added at the edge of the shape. 

 

2.1.1.7 Text 

A text is selected from the toolbar by clicking on the text icon. It is drawn by clicking on 

drawing area. A default text “OMSketch” will be drawn.  To edit the shape, double-click on the 

shape, a cursor is seen and the text can be changed. The text Features is not fully implemented. 

 

2.2 Shape Properties 

As mentioned above after a shape is drawn, handles are seen at edges of the shape. An 

additional rotate to handle is added at the top side of shape. The properties such as resize, translate 

and rotate can be performed dynamically.   

 

2.2.1 Resize 

A shape can be the size by clicking on the handles and moving them to the desire position. 

The shapes are dynamically resized by this action. 

 

2.2.2 Translate 

To translate a shape, click on the shape and move the shape. 

 

2.2.3 Rotate 

To rotate a shape, click on the rotate handle and move the mouse. Depending on the mouse 

move, the shape is rotated clockwise or anti clockwise.   

 

2.3 Shape Attributes 

A shape can be given pen and brush attributes. The pen has color, width and style properties, 

and brushes have color and fill style properties.  The pen color property is set by clicking the color 

icon in “Home” tab. The thickness is set, by choosing a value from the spin box in Home tab, the 

pen styles from the combo box. By default, the pen color is the black, thickness one and style line. 

Similarly, the brush properties can also be set. The color to fill is picked from a color dialog by 

clicking an icon "Fill Color," the brush fill style is set by clicking the No Brush button.   

 

2.4 Editing Shapes 

Multiple shapes can be selected by holding the control button and clicking on shapes. 

Shape/shapes can be cut, copy and paste.  
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2.4.1 Cut 

The cut operation can be selected from Edit menu or by clicking the edit icon in Home tab 

under Edit panel. Once this operation is performed the selected shape/shapes are removed from the 

drawing area. 

 

2.4.2 Copy 

To copy shape/shapes select the copy option from the edit menu alternatively click the cut 

form edit panel of “Home” tab. 

 

2.4.3 Paste 

To paste the cut or copied shape/shapes, select the paste option from edit menu or by 

clicking the paste icon from the above-mentioned panel. Once the operation selected the shapes are 

pasted back to the scene.   

 

2.5 Open and Save shapes 

2.5.1 Open 

To open a shape file select the open option from File menu alternatively click the open icon 

from “Home” tab. A file dialog is seen; select the desired file through this dialog. The shape is 

drawn on the drawing area.   

 

2.5.2 Save 

To save shape/shapes select the save option from File menu or click the save icon from 

“Home “tab’s file panel.  A file dialog box will appear, and the shape/shapes can be saved to two 

file formats jpg and bmp. 

 

Figure 2.5 Save Dialog 
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2.6 Export and Import 

Shapes can be exported into OMNotebook document. Similarly, the shapes can be imported 

from OMNotebook document to OMSketch. 

2.6.1 Export 

To export shape/shapes, initially in OMNotebook document select the cell and in OMSketch 

select the export option. The option can be select from File menu>Export Image or by clicking the 

Export icon from “Home” tab. The image is exported the cursor position in OMNotebook 

document. 

Figure 2.6 Export Shape 

2.6.2 Import 

 

To import shape/shapes to OMSketch, Select the image or shape and press the cntrl+E 

button on key board.  This action exports the shape to OMSketch editor.    

  

 

 

 

 

 

 

 

Exported Image 
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Figure 2.6.1 Imported Shape 

Imported Image 
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Chapter 3 QT Trolltech 

 

             Qt is a cross platform application UI framework providing efficient libraries to develop a 

large-scale web-based, mobile and stand alone applications. It is enriched with widgets, graphical 

components, and provides 2D and 3D Graphical API’s and web-based APIs. It provides SDK 

(Software development kit) to develop GUI and graphical applications, web applications, and 

mobile based applications. The SDK libraries are provided in C++ and Java. It also provides an IDE 

(Integrated developed environment) to develop applications. It also provides plug-ins to develop 

applications on other IDEs such as Microsoft Visual Studio's and Eclipse. As stated above, Qt is a 

cross platform application supporting about seven operating systems such as Microsoft Windows, 

Linux/X11, Mac OS, Embedded Linux, Windows CE, Maemo/MeeGo and Symbian. 

 

  For developing OMSketch application various Qt APIs are used. For convince the API's in 

this work   are classified into three categories. They are Central application, Drawing and Dialog 

APIs.  The central application and Dialog APIs are graphical components that are used for 

performing different operations.      

 

3.1 Central Application API's 

            This section gives a brief introduction on Qt API’s that are used for developing the central 

GUI interface of OMSketch application. 

 

3.1.1 QMainWindow 

QMainWindow provides methods to manage the application window frame work.  Different 

GUI components such as menu bars, dock widgets, Toolbars, status bars can be added to its layout. 

In OMSketch application, QMainWindow manages menus, tab widgets, layouts and the drawing 

area. Widgets supported by the OMSketch application are discussed in the coming sections. 

 

3.1.2 QGraphicsView 

  QGraphicsView [15] class provides a widget to display the graphical items of 

QGraphicsScene class. It acts as a view port which can be scalable. It provides methods to set the 

QGraphicsScene contents and view them. 

 

3.1.3 QMenu 

  A QMenu [16] object provides methods for adding items to the menu list. QMenu supports 

different types of menu styles. QMenu widget provides a menu for menu bars, context menus and 

popup menus. QMenu items are added to QMenuBar [17] providing a drop-down menu. Menu 

items are listed of action items. The menu items can be separated using addSeparator method. The 

submenus can be added using an addMenu method. The clear method is used to clear the menu 

items and removeAction method is to remove the action events of the menu item.    
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3.1.4 QAction 

  QAction [18] object contains methods that are triggered when a menu item is clicked. There 

are four types of actions in Qt. They are separators, actions for submenu, widget actions and actions 

performing other actions. Every menu item is associated with a specific action. When clicked on a 

menu item its action takes place on slots. Slots are the methods triggered when the menu item is 

selected. 

 

3.1.5 QLayout 

  It supports different types of layout to manage the contents of the window. QLayout [43] is 

the central layout and it is inherited by all the layouts supported by Qt [43]. For OMSketch 

application, QGridLayout [29], QHBoxLayout [31] and QVBoxLayout [47] are used. QGridLayout  

inherits QLayout and places the GUI components in a regular grid. Different methods are provided 

by this layout to manage the object. QHBoxLayout inherits the QBoxLayout, which is inherited 

from QLayout. QHBoxLayout places the window objects in a horizontal alignment. QVBoxLayout 

also inherits the QBoxLayout and places the window objects in a vertical alignment. 

 

3.1.6 Other Qt Widgets 

         It provides buttons, labels, option boxes, choice boxes, frames and many widgets. These are 

connected to layouts. In developing OMSketch layouts QPushButton [24], QTabWidget [45], 

QGroupBox [28], QLabel [25], QComboBox [26] and QSpinBox [27] objects have been used. 

QTabWidget is very useful in developing an application containing many "GUI" components. It 

manages space through its tabs. Several "GUI" components can be added into a single tab and a 

Tab widget can have many tabs. QPushButton is used for perform button associated actions. 

QLabel is used for labeling the widgets. QGroupBox provides a widget that has an appearance of a 

frame. It can accommodate "GUI" components in it. QComboBox, QSpinBox is used for selecting 

an item from a list of items. All the classes discussed above provide methods to set and get the 

specific content.  The widgets are shown as follows. 

 

 

Figure 3.1 Widget images 

3.2 Qt Drawing API's 

This section gives a short introduction to various procedures and API used by OMSketch to 

draw shapes.   
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3.2.1 QGraphicsScene 

QGraphicsScene is a container object. This object contains methods that handle drawing of 

shapes, Mouse Events, and Keyboard Events. Every shape is added as an item to this object. 

QGraphicsScene objects have very efficient methods to handle the shapes.  QGraphicsScene 

SceneRect method manages the drawing area. 

 

 3.2.2 QGraphicsItem 

This object contains methods to manipulate the properties of the shapes. The 

QGraphicsScene objects add every shape as a QGraphicsItem to it. QGraphicsItem is inherited by 

QGraphicsLineItem, QGraphicsEllipseItem, QGraphicsPathItem, QGraphicsRectItem, 

QGraphicsSimpleTextItem and QGraphicsTextItem. QGraphicsItem object provides methods to 

check whether the mouse click is positioned on them, set different pen styles, brush styles and 

cursor styles. This object also has methods to perform transformations, rotations and scaling. The 

use of these methods is discussed in detail in coming sections. 

 

3.2.3 QPainter 

QPainter object is the central object to perform the low-level painting on the widgets. All the 

other painting objects inherit this object to paint on the widgets. The QPainter object provides 

methods for drawing shapes in Qt. Some of them are lines, rectangles, rounded rectangles, arcs, 

poly lines, polygons and QPainterPath and QPixMap etc. 

 

3.2.3 QPainterPath 

QPainterPath object provides methods to draw basic shapes like lines, rectangles, rounded 

rectangles, ellipse, texts, etc. It can also be used to combine one or more shapes to from a single 

new shape.  The QPainter class has a method to add the QPainterPath shapes. 

 

3.2.4 QPen, QBrush 

QPen and QBrush methods provide pen and brushes to draw graphical shapes. The QPen is 

used for drawing the shapes with different colors, different patterns and widths. This object contains 

methods to get and set colors, patterns and widths. QPen, QBrush are used to set different patterns 

to the shape boundary and to fill shape respectively. It supports about fifteen patterns that can be 

filled. This class provides methods to set the color and patterns. The setStyle method is used to set 

the different fill patterns to QBrush. 
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3.3 Qt Dialog Boxes 

This section introduces to Qt's dialog objects used in OMSketch application. Two types of 

dialog boxes are used in this application. File dialog box for various file options and color   dialog 

box for selecting colors. 

 

3.3.1 QFileDialog 

The QFileDialog object provides a widget. This widget has features to perform different file 

actions. The user can choose to open or save a file. It provides functions to filter out the type of file 

to be opened or saved, the default directory to open or save into every time.   

 

3.3.2 QColorDialog 

The QColorDialog is a widget. This widget contains a wide range of colors that can be 

selected. The QDialog object provides methods to get the current color chosen.
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Chapter 4 OMNotebook document and OMSketch 

OMNotebook document is a cross platform application running on Windows, Ubuntu and 

Mac OS. On Windows platform, Microsoft Visual Studios has been used to develop OMNotebook 

document and in Ubuntu (Linux) a specific IDE is used but compiled in the standard Linux way 

using to make files. OMSketch also follows the same procedures for development on both 

platforms. A Qt SDK version 4.7 is used to develop the OMSketch application in this work. 

 

4.1 OMSketch Development 

OMSketch is a graphical editor to OMNotebook document. OMSketch can be used for 

drawing shapes and embed them into an OMNotebook document. OMSketch provides different 

types of shapes; regular and irregular. The drawn shapes can be exported or embedded into 

OMNotebook document or saved into different graphical file formats such as BMP, PNG and many 

more file formats supported by Qt [48].  The different file formats supported by Qt are discussed in 

Chapter 8 Save and Open files. The OMSketch application is designed in a simple and effective 

way. The rich GUI provided by Qt gives a smooth feel and look. OMSketch uses widgets, dialog 

boxes and 2D graphical APIs of Qt SDK to develop its components. The flow diagram of 

OMSketch can be illustrated as follows. 

 

 
Figure 4.1 OMSketch overview 
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The above diagram can be explained as follows: - The OMSketch application is managed by four 

main objects. The Tools object is the central in application and inherits Notebook class of 

OMNotebook document and QMainWindow of Qt. The Graph_Scene object provides methods to 

draw shapes and manage them. The Scene_Object object contains methods to search for the shapes 

in the scene. The Sketch_Files class provides methods to read and write the OMSketch files. 
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Chapter 5 OMSketch APIs and Application Frame Work 

  This chapter discusses APIs implemented in the OMSketch application and also the central 

layout application. It introduces various GUI components that are developed to support various 

operations that can be performed in the OMSketch application. 

 

5.1 Tools API 

The Tools class manages all other objects of OMSketch. This class has the methods that 

manage the main application layout of OMSketch. The QMainWindow class has different methods 

to manage the contents of the Scene. Tool's class inherits QMainWindow class. Thus, provides 

methods to set and manage Menus, Tab Widgets, Dialog Boxes and the drawing area. The widget 

used by Tool's class to develop the application is discussed in the coming sections. This class has 

methods to create new shapes, save shapes, open shapes, export shapes to OMNotebook document, 

and import shapes from OMNotebook document. This class also provides methods to handle the 

user interaction for choosing the type of shapes to be drawn, selecting different colors and styles for 

the shapes. The Graph_Scene object contains methods to handle drawing the shapes.  

 

5.2 Application Layout 

To develop a graphical editor the most priority objectives are design, user interaction and 

efficiency in usage. The aim is to allow easy interaction by providing components such as menus, 

tab widgets, different shapes and styles, etc. in the application. The most common input devices 

used for drawing and performing all options are the mouse and the keyboard. 

 

5.3 OMSketch Layout 

OMSketch is designed with a simple interface but is rich in graphical components. The main 

application is managed by Tool's class [reference section 4.1]. To the menu bar, different menus 

such as File Menu, Edit Menu, and Tools Menu are added. Each menu has items to perform their 

actions. Tab's widget has selection tabs, and each tab is formatted into panels consists of different 

tasks to select. The drawing area is auto adjusted according to the window size. A scroll bar is 

added automatically as its size increases. The main layout is shown as follows. 
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Figure 5.3 Main Layout 

5.4 Menus 

OMSketch has a menu to select tasks that can be performed on shapes. The menu items are 

instances of QMenu
 
[16]

 
class, and the QMenu instance is added to QMenuBar [17]. The menus in 

OMSketch are File Menu, Edit menu, Tools menu. These classes are contained in the Tools class. 

The code snippet for the initialization of these classes can be shown as follows. 

 
fileMenu=menuBar()->addMenu(tr("&File")); 

 

editMenu=menuBar()->addMenu(tr("&Edit")); 

   

toolMenu = menuBar()->addMenu(tr("&Tools")); 

  

In the above code, fileMenu is an instance of QMenu, and menuBar () is a method of 

QMainWindow object to this a new menu is added with a title ("File"). The method returns the 

menu item that is copied into fileMenu object. Similarly, the editMenu and toolMenu objects are 

instantiated. 
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 5.5 File Menu    

The File menu contains options such as a New, Open, Save, Saveas, Import and Export. The 

first four options are used for creating new file, saving a file, opening a file and saving an already 

saved file as with new file name using Save_as option. The Import option is used for importing 

images into the current drawing scene. Export option is used for exporting or embedding the current 

shape into OMNotebook document. 

 

 5.5.1 Edit Menu 

The Edit menu provides options such as cut, copy, paste, undo and redo. These operations 

can be performed on a single shape or on a group of shapes. The OMSketch application allows 

to select multiple shapes and perform the cut or copy and paste operations. 

 

5.5.2 Tools Menu 

This menu has shape items like Rectangle, Line, Rounded Rectangle, Ellipse, Text and many 

other complex shapes. The user can select the shape that he wants to draw. The Tools object 

contains actions associated with each menu item. When the user clicks on the menu item an event 

associated with that item is triggered, and the action is performed. 

 
       file_new = new QAction (tr ("&New"), this); 

        connect (file_new,SIGNAL(triggered()), this, SLOT(draw_new())); 

 

In the above code, file_new is a QAction object, and it is added to the file_Menu as an item. 

This file_new has a triggered action and when pressed on it draw_new () function is called. The 

draw_new () contains the respective logic to perform.   

 

 5.6 Tab Widget 

The Tab widget is a special type widget. It can accommodate many widgets in a single tab. It 

also allows a Tab widget [45]. In OMSketch application, it is used to manage file items, edits items 

and shape’s styles. Every tab in the application is displayed with different icon's representation of 

the options or tasks they perform. It gives a very easy way of interacting by providing the icons 

representing of tasks. 

 

          The First tab is titled as "Home" tab. This tab contains layouts such as File layout, Edit 

layout, and Styles Layout. Each layout contains different widgets with items they represent. The 

File layout contains the basic file operation as said in section above. To implement the file items 

QPushButton [reference section 4.11] object is used. QPushButton object provides various methods 

to perform the user tasks. Icons are set to buttons to represent the action they perform. Properties 

like Tooltips, changes of mouse pointers are set.  The File layout is a replica of File menu but 

represents all the items once. Similarly, the Edit layout is also implemented. This Edit’s layout is a 

replica of Edit file menu. 
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Style layout has three extra widgets apart from QPushButton. They are QLabel [25], 

QComboBox [26] and QSpinBox [27]. QLabel is used to label pen width. To select pen width 

QSpinBox is used. This drop box option widget allows selecting only one item at a time. The other 

two combo boxes are used to choose the pen styles and fill styles. The use of these options will be 

discussed in later sections. All the layouts in the Home tab are implemented using QGroupBox [28] 

this has looked of a frame widget? This object provides various methods to set title decorate a 

border and set tool tip. 

 

The tab widget is implemented in the main layout. First, the tab widget is instantiated in the 

Tools object constructor. Then this widget is added to the horizontal layout, and this layout is 

further added to QMainWindow widget. There are two tabs one for the general files and other for 

selecting shapes. The first tab “Home” contains three layouts. Each layout is an item of QGroupBox 

object. The QGroupBox widget has a look and feel of Frame widget. To this widget, a gridlayout 

widget is added. The grid layout widget is implemented using QGridLayout. The gridlayout widget 

manages the widgets added to it in a regular space. To this Grid layout, the pushbuttons widgets, 

label widgets and other widgets are added. The following code illustrates the implementation of tab 

widgets in OMSketch application. 

 
                        tabWidget = new QTabWidget();      

                     widget =new Qwidget(); 

                        layout = new QHBoxLayout(); 

                        widget->setLayout(layout); 

                        tabWidget->addTab(widget,"Home"); 

 

            The first line of the code initializes the tab widget item. In the second line, a QWidget item 

is initialized and to it a QHBoxLayout is added as a layout. Then to the tab widgets addTab method 

is used. This method adds a new tab. Here, the tab_widget with title "Home” is added as a new tab. 

The figure can be shown as follows. 

 

 

                           

Figure 5.6 Tab Widget 

5.7 Drawing Area 

           OMSketch has a drawing area. This is a QGraphicsView widget, this widget is added to a 

horizontal layout. The flow diagram of how the drawing widget has been designed in OMSketch 

application.  
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Figure 5.7 Drawing Area 

 

From the above flow diagram, the Graph_Scene object is passed into QGraphicsView object 

as a constructor argument. The drawing area size is specified. The widgets are added as the flow 

diagram shows. The implementation of above flow chart in OMSketch can be shown as follows. 

                        
                       view = new QGraphicsView(scene); 
             scene->setSceneRect(0,0,1200,800); 

             hlayout->addWidget(view); 

             main_widget->setLayout(hlayout); 

             setCentralWidget(main_widget); 

 

In the above code "view" is an instance of QGraphicsScene object. This instance is 

initialized by passing "scene" the instance of Graph_Scene into QGraphicsView constructer object.  

setSceneRect method of "scene" instance is set to minimum and maximum coordinates. This 

method sets the coordinates of the drawing area. The drawing area coordinates are positive and 

width range from [0-1200] and height ranges from [0-800]. The drawing area coordinates can range 

from negative to positive also. Then this view is set to horizontal layout and the layout to a widget. 

This widget is added to a central widget. That manages the scene. 

 

5.7.1 Drawing in OMSketch 

OMSketch supports different types of shapes and texts. The users can choose regular and 

irregular shapes and texts to draw. The shapes can be selected from a menu bar or from a tab widget 

as shown in the image number and section number. It provides different objects to perform drawing. 

In this application, QGraphicsScene [8] and QPainter [19] objects are used. QGraphicsScene object 

is specially used for 2D drawings. It can manage the items (the shapes are added as items) in the 

scene. It is a container object that can hold 2D items. It has event methods to handle mouse and 

keyboard inputs. It provides methods for managing the shapes in the scene.    

 

          Graph_Scene class handles all the drawing-related methods. This class inherits 

QGraphicsScene class. The QGraphicsScene class contains methods to handle the mouse and 

keyboard events and handle the shapes. Every shape is added as an item. The mouse and keyboard 

events are virtual protected methods, and these methods can be overridden by the class that inherits 

QGraphicsScene. The mouse functions overridden are mousePressEvent, mouseMoveEvent, 

mouseReleaseEvent and mouseDoubleClickEvent. The keyboard functions are keyPressEvent and 

keyReleaseEvent.                         
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Every shape is drawn using a mouse. OMSketch has ten types of shapes. The shapes and 

their methods are discussed in detail in the section no.5; every shape is initialized by selecting them 

from the toolbar of main application layout. When clicked on the drawing area the 

mousePressEvent method triggers. This method contains the function draw_objects. This function 

asserts whether the mouse clicked position is on a shape or not. If the mouse clicked position is on a 

shape, then it invokes the shape that mouse is clicked on. If not the default shape chosen is drawn. 

Every shape is drawn dynamically that is the shape size can be resized dynamically. Once the 

mouse is pressed and moved the shape size is automatically resized. The mouse move event 

mouseMoveEvent method is invoked. This method has knowledge of what shape item is currently 

been drawing. The mouseReleaseEvent method completes the shape that is currently selected for 

drawing. Some shapes need the mouseDoubleClickEvent method; in this method, the complete 

shapes are drawn. The code sample for mouse event methods in OMSketch is shown as follows. 

 
 void mousePressEvent(QGraphicsSceneMouseEvent *); 
 
  void Graph_Scene::mousePressEvent(QGraphicsSceneMouseEvent *event) 
  { 

    bool k=false; 

    if((event->button()==Qt::LeftButton)||(isMultipleSelected)) 

    { 

        //Mouse position is stored in strt_pnt and strt1_pnt; 

        strt_pnt=event->scenePos(); 

        //Function to select the object to be drawn 

        draw_objects(); 

     

     } 

     QGraphicsScene::mousePressEvent(event); 

 } 

The first line of the code shows the declaration of the mouse press method. It takes 

QGraphicsSceneMouseEvent [32] as a reference argument into it. The next line shows the 

implementation of the method. The “event” object contains methods to check what button is 

pressed. The above code checks whether a mouse left button is pressed or not.  If the left button is 

pressed, then the draw_objects () method is invoked. This is discussed in further sections. strt_pnt 

variable stores the present mouse position.     

         void mouseMoveEvent(QGraphicsSceneMouseEvent *); 

         void Graph_Scene::mouseMoveEvent(QGraphicsSceneMouseEvent *event) 

         { 

             if(draw_object_state==1) 

             draw_line_move(event->lastScenePos(),event->scenePos()); 

             QGraphicsScene::mouseMoveEvent(event); 

        } 

This method takes QGraphicsSceneMouseEvent objects and checks what object is selected 

for drawing. Other types of actions can also be invoked when the mouse is moved. The 

draw_line_move method takes previous mouse press position and present mouse press position as 

input. It also contains other different methods to perform various operations on lines. The 

draw_line_move method will be explained in further section.   
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   void mouseReleaseEvent(QGraphicsSceneMouseEvent *); 

    void Graph_Scene::mouseReleaseEvent(QGraphicsSceneMouseEvent *event) 

    { 

         if((event->button()==Qt::LeftButton)) 

         { 

             if(draw_object_state==1) 

             { 

                draw_line_state(event->lastScenePos(),event->scenePos()); 

             } 

         } 

         QGraphicsScene::mouseReleaseEvent(event); 

    } 

This method is triggered when the mouse button is released.  In Graph_Scene class, this 

method is used for completely drawing a shape or what type of action is done. In the above code, 

the draw_line_state method takes the mouse pervious and current values as inputs. The working of 

this method is discussed in further section.          

   void mouseDoubleClickEvent(QGraphicsSceneMouseEvent *); 

   void Graph_Scene::mouseDoubleClickEvent(QGraphicsSceneMouseEvent   

                                                  *event) 

   { 

        if(text->getMode()) 

        { 

           text->item->setTextInteractionFlags(Qt::TextEditorInteraction); 

        } 

   } 

 

 

The mouseDoubleClickEvent method is an overridden method from QGraphicsScene class. 

This method takes a QGraphicsSceneMouseEvent class object as a reference. The 

QGraphicsSceneMouseEvent class contains many methods. However, in Graph_Scene class they 

are not used. In Graph_Scene class, the mouse double clicks method is used for only two shape 

items. 

            

The keyboard event methods are generally used for cut, copy, paste and deleting the shapes. 

The keyPressEvent method is used. For the group operations, the keyReleaseEvent method is also 

used. The code for both the functions can be shown as follows. 

                    
             

 

 void keyReleaseEvent(QKeyEvent *); 

  
     void Graph_Scene::keyPressEvent(QKeyEvent *event) 
     { 

         if(event->key()==0x01000007) 

         { 

             if(draw_object_state!=0) 

             { 

               if((draw_object_state==1)&&(line->getMode())) 

               { 

                   removeItem(line->item); 

                   objects.remove(object_indx); 

                   lines.remove(indx); 

               } 

          } 
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        } 

        QGraphicsScene::keyPressEvent(event); 

   } 

The keyReleaseEvent method is a virtual method of QGraphicsScene class handles the key 

board events. This method is overridden in Graph_Scene class for various actions. For example, to 

perform operations such as cut, copy, paste, delete and group selection. It takes QKeyEvent as 

reference. This class has methods and key events. The above code checks to delete shapes. To delete 

shape it checks whether a delete key is pressed? If it is pressed, then-current selected shape is 

deleted. Similarly, the group operations are also performed.        

      void keyReleaseEvent(QKeyEvent *); 

void Graph_Scene::keyReleaseEvent(QKeyEvent *event){ 

    QGraphicsScene::keyReleaseEvent(event); 

} 

This method is also virtual function overridden in Graph_scene class. This method also 

takes QKeyEvent object’s reference. This method is not implemented but just initialized for future 

use.
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Chapter 6 Drawing Shape 

OMSketch has two types of shapes; they are Standard shapes and Non-Standard shapes. The 

standard shapes are those that have definite shape such as lines, ellipses and rectangles. Non-

standard shapes are those that are composed of two or more standard shapes.  The following 

diagram shows some standard and non-standard shapes. 

 

 
Figure 6 Standard and Non-Standard Shapes 

6.1 Standard Shapes        

To draw standard shapes Qt has many classes. These classes have various methods that can 

be used to manipulate the shapes. Some of the standard shape classes are QGraphicsLineItem [11], 

QGraphicsRectItem [13] and QGraphicsEllipseItem [10]. To build shapes in this application 

QGraphicsPathItem class is inherited. QGraphicsPathItem is a container class that contains many 

methods for building regular shapes such as lines, rectangles, ellipses and polygons. This 

QGraphicsPathItem object can also combine one or more regular shapes to form a new non 

standard shape. So every shape except Text shape is implemented using this class. Since 

QGraphicsScene, class renders or adds every shape as an item, the shapes drawn using 

QGraphicsPathItem are given to QGraphicsPathItem object; this class converts the shapes into 

items. The "Text" in OMSketch is implemented using QGraphicsTextItem. As mention above 

QGraphicsItem class is a base object. The reason QGraphicsPathItem object is used for all shapes 

because it gives uniformity in the implementation. The QPainterPath class also has text drawing 

function, but it does not provide more functions to manipulate. So QGraphicsTextItem class is used.  

 

As shown in flow chart every shape is an instance of a specific object. Every standard and 

non-standard shape objects inherit QGraphicsPathItem object. The shapes in OMSketch are 

represented as the following flow chart. 
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Figure 6.1 Shapes Overview 

6.2 Initializing Shapes        

 
                   if(round_rects.size()==0) 

 { 

    Draw_RoundRect* round_rect2 = new Draw_RoundRect(); 

    round_rect2->setStartPoint(strt_pnt); 

    round_rect=round_rect2;        

     round_rects.push_back(round_rect2); 

    round_rect->item=newQGraphicsPathItem(round_rect 

                                          ->getRoundRect(strt_pnt,strt_pnt)); 

    addItem(round_rect->item); 

} 

  

         

The above code illustrates rounded rectangle drawing procedure. First, the 

Draw_RoundRect object is initializing and initial point is stored through setStartPoint method. Then 

the object is copied to a temporary variable. This temporary variable will be use in rest of the 

application. Then the object is pushed into a list. The next step the rounded rectangle shape item is 

created and added to the scene through addItem method. The shape’s methods are discussed in 

detail in coming sections. 
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6.2.1 Dynamic drawing of shapes and Editing 

Once the shape is initialized, depending on the mouse move shape size increases or 

decreases dynamically. The mousePressEvent method is invoked. This method contains methods 

              

about the shape presently selected for drawing an appropriate method is triggered from this method. 

The methods are named after the shape name.  For example, for the same rounded rectangle in the 

mousePressEvent the method invoked will be "draw_round_rect_move". This method handles 

different tasks.  This method is used for drawing a new shape selected dynamically and also for 

resize, move and rotate the already drawn shape. The code for the rounded rectangle can be shown 

as follows. 

       
          for(int i=0;i<round_rects.size();i++) 

    { 

        if((pnt1!=pnt)&&(round_rects[i]->getMode()==false)) 

        { 

       round_rect->item->setPath(round_rect->getRoundRect(round_rects[i]-                                      

>getStartPnt(),pnt1)); 

        } 

     } 

        This code demonstrates how the shape is dynamically drawn when the mouse is moved. It 

goes through the current list of objects inserted into the list (the previous section code) and gets the 

current object drawing; this is done through by checking the method getMode of the shape. This 

method returns, whether the shape is completely drawn or not. If not completely drawn, then the 

setPath method draws the round rectangle to the current position of the mouse. 

6.2.2 Completing the shape 

The shape is completely drawn when the left mouse button is released. The 

mouseReleaseEvent is triggered, and this method invokes an exact method depending on the 

present selected shape. Rounded rectangle example, the "draw_round_rect_state" is invoked. This 

method can perform several tasks. For the present drawing shape, the end coordinates and other 

properties are stored to shape class in this method. For an already drawn shape, the present state is 

released. If the shape is in moving state, the state will be disabled, and the shape properties are 

updated. The code for a rounded rectangle can be stated as follows. 
 

    Scene_Objects* object = new Scene_Objects(); 
    if(round_rect->getMode()==false) 

    { 

        last_pnt=pnt1; 

        round_rect->setMode(true); 

        round_rect->setEndPoint(pnt1); 

        round_rect->item->setPos(0,0); 

        round_rect->setEdgeRects(); 

        addItem(round_rect->Strt_Rect); 

        addItem(round_rect->End_Rect); 

        addItem(round_rect->Rot_Rect); 

        round_rect->Strt_Rect->setPos(0,0); 

        round_rect->End_Rect->setPos(0,0); 

        round_rect->Rot_Rect->setPos(0,0); 



OMSketch - Graphical Sketch Editor in OpenModelica Interactive Notebook 

________________________________________________________________________________ 

________________________________________________________________________________ 

31 

 

         

        object->setObjects(5,round_rects.size()-1); 

        object->pen=pen; 

        object->setbrush(brush); 

        object->ObjectIndx=round_rects.size()-1; 

        objects.push_back(object); 

    } 

 

The mouse release method draws the current shape completely. Some methods of 

Draw_RoundRect are set. The setMode method is set true stating the shape is completely drawn and 

also the last point where the mouse is released is set through setEndPoint method. This point is the 

end position of the shape. Then setEdgeRects method is called and the edge handlers of the shape 

are added to the scene. Then a template class object is initialized, and the shape’s attributes are set 

to it.       
 

6.3 OMSketch Shape Managing Classes 

Every shape in OMSketch is an object of its respective class. All standard shape’s objects 

have same methods and variables. For non standard shapes, extra methods and variables are added 

along with standard shape methods. The standard shape classes of OMSketch application are 

Draw_Line, Draw_Rectangle, Draw_RoundRect and Draw_Ellipse. These classes inherit 

QGraphicsPathItem class. Every class contains getter and setter methods. GetStartPnt, GetEndPnt 

are used as getters and setStartPoint, setEndPnt are used as setters. They also contain methods to set 

the pen color, pen width, pen style. Similarly, the brush color, brush pattern that is filled style is also 

implemented. To resize and rotate a shape, every shape contains three handlers. Two are rectangle 

shape items and other is an ellipse shape item. The rectangle shape items are implemented using 

QGraphicsRectItem class. These handlers are added at some position of every shape and used to 

resize and rotate the shape dynamically. The rotate handle is implemented using 

QGraphicsEllipseItem. The use of these handles is discussed in section no. The shape classes 

contain methods to check whether the mouse is clicked on the particular shape or not. The 

implementation code for the shape class is as follows. 

 

 6.4 Methods containing in Standard shapes 

6.4.1 GetStartPnt, getEndPnt, setStartPoint, setEndPnt 

These four functions are getters and setters methods for every shape object in OMSketch 

application. With these methods, the starting and ending position of shapes can be stored and 

retrieved. 

 

6.4.2 GetMode and SetMode 

           These two functions are used to get the status of the present shape drawn. A Boolean variable 

draw_mode is assigned and retrieved through these methods. If the draw_mode is false, the shape is 

presently in an uncompleted state. If it is true, then the shape is completely drawn. The draw_state 

variable has a vital role in this application and used in when performing cut, copy, paste on a group 

of shapes and also for resizing, translation and rotation of shape. 
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  void Draw_Rectangle::setMode(bool mode) 

  { 

     draw_mode=mode; 

  } 

  bool Draw_Rectangle::getMode()        

   {            

  return draw_mode;         

   } 

     The value of draw mode can be accessed through setMode and getMode methods. 

 

6.4.3 GetState and SetState 

              These two methods are used for editing of the shapes. An integer variable draw_state is set 

and get through these methods. The draw_state variable takes values from one to four. Each value 

has a specific task to perform on the shape. For completely drawn shape the draw_state value can 

be set. When the draw_state value is one, then the initial position of the can be resized. When it is 

two, the other end of the shape can be resized and value of three the shape can be moved at any part 

of the scene and value of four the shape can be rotated. These values are set when a user clicks on 

what sub shape of the present shape. That is clicked on handles, on the shape itself or on the ellipse. 

The draw_state is reset when the mouse left button is released. 
 

   void Draw_Rectangle::setState(int state) 

 { 

      draw_state=state; 

 } 

 int Draw_Rectangle::getState()        

  {            

      return draw_state;         

  } 

    The methods setState and getState returns the draw_state value for the shape. The draw_state 

is set as said above. 

6.4.4 Draw Shape 

 A shape is drawn by calling the method getShapeName. For example, for drawing rectangle 

shape the method is getRect, for line getLine, for ellipse getEllipse, for polygon getPolygon and so 

on. All these methods return a QPainterPath object. The QPainterPath [20] class has been drawing 

functions to draw shapes such as  lines, rectangles, arcs, rounded Rectangles and also capable of 

drawing complex shapes by combining two or more standard shapes. In this method, the shapes are 

drawn by giving the initial and end points to the QPainterPath object, then the respective shape is 

set, and QPainterPath is returned. In Scene_Graph class, the returned shape object is set to 

QGraphicsPathItem, and it is added to the scene. The code can be illustrated as follows. 

 
 

QPainterPath Draw_Rectangle::getRect(QPointF pnt,QPointF pnt1) 

{ 

    StrtPnt=pnt; 

    EndPnt=pnt1; 

    QPainterPath path; 

    path.addRect(QRectF(StrtPnt,EndPnt)); 
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   return path; 

} 

 

The above procedure is to draw the shape and returns shape. The starting and ending points 

of the shape are retrieved from its own getStrtPnt and getEndPnt methods. Then a QPainterPath 

object is initialized, and addRect method of this object is called to draw a rectangle. Then the path 

is returned. This path is added to QGraphicsPathItem object that is further added to the drawing 

scene as item. The implementation of this method is same in all shape objects, except for the text 

shape item. The code for the text item can be shown as follows. 
 

void Draw_Text::getText() 

{ 

    item->setPos(StrtPnt); 

     

    item->setPlainText(this->text); 

} 

 

For the text, the text is set to the plain text method of QGraphicsTextItem. The item variable 

in the above code is an object of QGraphicsTextItem. To this object the text is set and added to 

drawing scene as item. 

 

6.4.5 SetEdgeRects and UpdateEdgeRects 

When every shape is drawn completely three handles are added to the shape. The method 

setEdgeRects is called to add these handles to the shapes. The updateEdgeRects method is used to 

update the edges when translation, resizing and rotation of shape are done. The code can be 

illustrated as follows. 
 

  void Draw_Rectangle::setEdgeRects() 
  { 

      QBrush rectbrush; 

      rectbrush.setColor(QColor(0,175,225)); 

      rectbrush.setStyle(Qt::SolidPattern);      

       Strt_Rect = new QgraphicsRectItem(QRectF(QPointF(StrtPnt.x()-5.0,  

       StrtPnt.y()-  5.0),QPointF(StrtPnt.x()+5.0,StrtPnt.y()+5.0)));  

       Strt_Rect->setBrush(rectbrush);       

       End_Rect = new QGraphicsRectItem(QRectF(QPointF(EndPnt.x()-5.0,  

                EndPnt.y()-5.0),QPointF(EndPnt.x()+5.0,EndPnt.y()+5.0))); 

     End_Rect->setBrush(rectbrush); 

      QPointF pnt1,pnt2; 

      pnt1.setX(((StrtPnt.x()+EndPnt.x())/2)-5); 

      pnt1.setY(StrtPnt.y()-20); 

      pnt2.setX(((StrtPnt.x()+EndPnt.x())/2)+5); 

      pnt2.setY(StrtPnt.y()-10); 

      Rot_Rect = new QGraphicsEllipseItem(QRectF(pnt1,pnt2)); 

      Rot_Rect->setBrush(rectbrush); 

}            
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Figure 6.4 Shape Handles 

The handles at starting and ending position of the shape are for resize the shape and the 

third handle is for rotating the shape. To draw these handles shapes starting and ending points are 

used. The handles are added as shown in the code. The implementation of this method is same in all 

other shape objects. Then the shapes are added to the scene in mouse release method. 

 

 

void Draw_Rectangle::updateEdgeRects() 

{ 

     

     Strt_Rect->setRect(QRectF(QPointF(StrtPnt.x()-5.0,StrtPnt.y()-  

                   5.0),QPointF(StrtPnt.x()+5.0,StrtPnt.y()+5.0))); 

     End_Rect->setRect(QRectF(QPointF(EndPnt.x()-5.0,EndPnt.y()-   

                   5.0),QPointF(EndPnt.x()+5.0,EndPnt.y()+5.0))); 

    QPointF pnt1,pnt2; 

    pnt1.setX(((StrtPnt.x()+EndPnt.x())/2)-5); 

    pnt1.setY(StrtPnt.y()-20); 

    pnt2.setX(((StrtPnt.x()+EndPnt.x())/2)+5); 

    pnt2.setY(StrtPnt.y()-10); 

    Rot_Rect->setRect(QRectF(pnt1,pnt2)); 

    Strt_Rect->update(); 

    End_Rect->update(); 

    Rot_Rect->update(); 

} 

 

The method updateEdgeRects implementation is same as the setEdgeRects method. 

However, the difference is in this method setRect method is used to reset the handles. This method 

is called in the mouse move method of Graph_Scene. This method is called when resizing, 

translation and rotation of shape is performed. The handles are updated according to the action 

performed. 
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6.4.6 Setting the State of the Shape 

There are four methods that set the state of the shape. The state of the shape states the type 

of action performs on the shape. That is resized, translate and rotate. Four different methods are 

called to get the state. The getStartEdge method returns, whether the mouse press position is on the

              

starting handle, the getEndEdge method returns the whether the mouse is pressed on end handle. 

The getRotEdge returns the state for rotation and getItemSelected return the state for translate.  The 

variable draw_state is set accordingly. The variable draw_state is set accordingly. The code can be 

illustrated as follows. 

 
    bool Draw_Rectangle::getStrtEdge(QPointF pnt) 

    { 

        if(Strt_Rect->isUnderMouse()) 

        { 

           draw_state=1; 

           Strt_Rect->setCursor(Qt::CrossCursor); 

           return true; 

        } 

      } 

    bool Draw_Rectangle::getEndEdge(QPointF pnt); 

    bool Draw_Rectangle::getItemSelected(const QPointF pnt); 

 

The methods getStartEdge, getEndEdge and getItemSelected are invoked, if the mouse is 

pressed on the start handle, end handle and shape. The getStartEdge method illustrated above. 

Similarly, getEndEdge and getItemSelected methods are implemented. The draw_state variable is 

set accordingly. If a mouse is press on start handle, then draw_state is set to 1, if mouse press on 

end handles, then draw_state is set to 2, if mouse press on a shape, then draw_state is set to 3. The 

implementation of these methods is same in all shape objects. The draw_state value is used in the 

mouse move method of Graph_Scene class. 
 

bool Draw_Rectangle::getRotEdge(const QPointF pnt) 

{ 

    if(Rot_Rect->isUnderMouse()) 

    { 

        draw_state=4; 

        QPointF pnt1; 

        pnt1.setX((Rot_Rect->boundingRect().topLeft().x()+Rot_Rect-  

              boundingRect().bottomRight().x())/2); 

        pnt1.setY((Rot_Rect->boundingRect().topLeft().y()+Rot_Rect-  

              >boundingRect().bottomRight().y())/2); 

        item->setTransformOriginPoint(pnt1); 

        Strt_Rect->setTransformOriginPoint(pnt1); 

        End_Rect->setTransformOriginPoint(pnt1); 

        Rot_Rect->setTransformOriginPoint(pnt1); 

        return true; 

    }  

     

} 

The getRotEdge method is different. The origin of the shape is first shifted from the scene 

left corner to the center of the shape. That is the shape rotates around itself. When clicked on center

             



OMSketch - Graphical Sketch Editor in OpenModelica Interactive Notebook 

________________________________________________________________________________ 

________________________________________________________________________________ 

36 

 

              

handle the draw_state value is set to 4. The implementation of this method is same in all other shape 

objects. This method is called in mouse move method of Graph_Scene. 
 

6.4.7 SetTranslation and setRotation 

setTranslation method is used for translating the shape from one position to be other. The 

shape can be translated by holding the shape with mouse pressed on it and move it to desired 

             

              

position. SetRotation method is used for rotating the shape according to mouse move.  The code 

sample for setTranslation method can be shown as follows. 
 

 

void Draw_Rectangle::setTranslate(QPointF pnt,QPointF pnt1) 

{ 

    if(draw_state==3) 

    { 

       item->setPos(item->pos()-(pnt-pnt1)); 

       Strt_Rect->setPos(Strt_Rect->pos()-(pnt-pnt1)); 

       End_Rect->setPos(End_Rect->pos()-(pnt-pnt1)); 

       Rot_Rect->setPos(Rot_Rect->pos()-(pnt-pnt1)); 

       item->update(); 

       Strt_Rect->update(); 

       End_Rect->update(); 

    } 

    if(draw_state==1) 

    { 

       Strt_Rect->setPos(Strt_Rect->pos()-(pnt-pnt1)); 

       Strt_Rect->update(); 

    } 

    if(draw_state==2) 

    { 

       End_Rect->setPos(End_Rect->pos()-(pnt-pnt1)); 

        

     End_Rect->update();                     

} 

} 

SetTranslation method takes two-point variables. These variables are mouse present mouse 

position and previous position. The translation position is calculated from the difference of the two 

positions. The handles are updated as seen in the implementation. The implementation of this 

method is same in all shape objects, and they are called in mouse move method. 

void Draw_Rectangle::setRotate(const QPointF &pnt,const QPointF &pnt1) 

{ 

    if(pnt1.x()>pnt.x()) 

    { 

       angle+=0.5; 

       item->setRotation(angle); 

       Strt_Rect->setRotation(angle); 

       End_Rect->setRotation(angle); 

       Rot_Rect->setRotation(angle); 
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    } 

    if(pnt.x()>pnt1.x()) 

    { 

       angle-=0.5; 

       item->setRotation(angle); 

       Strt_Rect->setRotation(angle); 

       End_Rect->setRotation(angle); 

       Rot_Rect->setRotation(angle); 

    } 

    item->update(); 

     

    Strt_Rect->update(); 

    End_Rect->update(); 

    Rot_Rect->update(); 

 } 

 

    The setRotation method also takes two arguments same as setTranslate method. In this 

method, the arguments are used for comparison. If pnt1.x () is greater than pnt.x () then a clock-

wise rotation is done, and the angle is increased by 0.5 for every mouse move. If pnt1.x () is less 

than pnt.x () then the anti clock-wise rotation is done. The same 0.5 angle is decreased for each 

mouse move. Then all shape items are updated.   

 

6.4.8 Getting and Setting Pen and Brush properties 

The properties for the pen are set using methods setPen, setPenStyle, setPenWidth and 

getPen. The setPen method is used to set the pen's color, setPenStyle for pen style and setPenWidth 

for pen width. The getPen method returns the current pen used for the shape. Similarly, the brush 

properties are a set for the shape using the methods setBrush, setBrushStyles and getBrush. 

SetBrush method is used to set the color of the brush that is filled style of the shape. SetBrushStyles 

method sets the pattern that is the fill style according to user choice.  The more detail explanation of 

different brush properties supported by Qt is given in [4]. The code can be shown as follows. 

 
  void Draw_Rectangle::setPen(const QColor color) 

  { 

       this->pen=item->pen(); 

        

       this->pen.setColor(color); 

       item->setPen(pen); 

  } 

The setPen method sets the color of the pen. It takes a const QColor object as argument and 

sets it as the pen color. Using setPen method the pen is set to the shape. The more about the color 

choosing is discussed in coming section.   

void Draw_Rectangle::setPenStyle(const int style)     

 {            

     switch(style)          

     {            

  case 1:          

    this->pen=item->pen();        
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   this->pen.setStyle(Qt::SolidLine);       

   item->setPen(pen);         

   break;           

   default:           

   break; 

    } 

} 

The setPenStyle method sets the QPen styles. This method takes the style integer as input 

and sets the pen to appropriate style. Only one case is shown in the above method, but it supports 

many styles. The more detail about the pen style is discussed in the section 5.5. 

  

  void Draw_Rectangle::setPenWidth(const int width) 

  { 

       this->pen=item->pen(); 

       this->pen.setWidth(width); 

       item->setPen(pen); 

  } 

  QPen Draw_Rectangle::getPen() 

  { 

       return pen; 

    } 

 

The setPenWidth takes an integer argument as input and set the pen according to it. The 

width takes up to five values. The getPen method returns the current pen of the shape. This method 

is used when a shape is saved to file or exported. 

      
  void Draw_Rectangle::setBrush(const QBrush brush) 

  { 

       this->brush=item->brush(); 

       this->brush.setColor(brush.color()); 

       item->setBrush(this->brush); 

  } 

  void Draw_Rectangle::setBrushStyle(const int style) 

  { 

    this->brush=item->brush(); 

    switch(style) 

    { 

      case 1: 

         brush.setStyle(Qt::SolidPattern); 

         item->setBrush(brush); 

          

      break; 

      default: 

         break; 

     } 

   } 

 

 QBrush Draw_Rectangle::getBrush() 

 { 

        return brush; 

 } 
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The setBrush method sets the shape’s brush color. The setBrushStyle method takes an 

integer argument and sets the brush style. There many styles supported by the brush. The getBrush 

method returns the current brush of the shape. This is used when saving the shape. The details about 

the brush color and brush styles are discussed in the section 5.5. 

 

6.5 Colors and Styles for Shapes 

The shapes can be drawn with different colors and styles. The main tab "Home" has the 

panel for Colors and Styles that have different color and style options that can be set for the shapes. 

To choose different colors for the shapes a color dialog box is provided. QColorDialog
 
[22] is used 

for selecting different colors. This dialog box object has methods to get the current color, to set the 

default color, is a color has been chosen and many other such as methods. Two color  dialog boxes

              

are used. One dialog box to set pen color and other dialog box to fill the shape with the color 

chosen that is for brush. Widgets are use to select pen width, pen styles and brush styles. The pen 

styles and width are used for setting the pen style and width, and the brush style is used for setting 

the fill style of the shape. 

 

QPen [23] class is used for drawing and setting the pen style of the object. QBrush
 
[4] is 

used for filling the shapes with different fill styles. QPen is like a pencil to draw shapes. This class 

has many methods. The methods used in this application are color, style and width. There are about 

five styles available in Qt. They are SolidLine, DashLine, DotLine, DashDotLine, DashDotDotLine 

and CustomLine. For example, the SolidLine is a default normal line; DashLine option draws the 

shape with a dash pattern and so on. The OMSketch application uses only first five options. Width 

of the pen sets the thickness of shape. Shapes can be drawn with five different widths. The pen’s 

attributes can be set as follows. 

 
void Tools::setColors() 

{ 

    color=color_dialog->getColor(QColor(255,255,255),this); 

    if(color.isValid()) 

    { 

        pen.setColor(QColor(color)); 

        scene->setPen(pen); 

    } 

} 

The setColors method calls a color dialog box. The color is an object of QColorDialog, and 

the initial color is white. If an “ok” button is clicked a true value is a return by isValid () method or 

false if a cancel button is clicked. Then the color is set to QPen object. This pen object is to pen 

property of current shape, thus the shape color is set. The figure of QColorDialog can be shown as 

follows.  

 

void Tools::pen_lineSolidStyle() 

{ 

     scene->setPenStyle(1); 

     pen.setStyle(Qt::SolidLine); 

} 
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void Tools::setPenStyles(int indx) 

{ 

    switch(indx) 

    { 

      case 1: 

          pen_lineSolidStyle(); 

         break; 

       

       default: 

         break; 

    } 

       } 

The setPenStyle takes an integer argument. This method contains and a switch case selects 

an appropriate method. For example, pen_lineSolidStyle () method to set solid pen style. 

 

void Tools::setPenWidths(int width) 

{ 

    //setting different pen widths 

    scene->setPenWidth(width); 

    switch(width) 

   { 

      case 0: 

         pen.setWidth(1); 

         break; 

      case 1: 

         pen.setWidth(2); 

         break; 

      case 2: 

         pen.setWidth(3); 

         break; 

      case 3: 

         pen.setWidth(4); 

         break; 

      case 4: 

         pen.setWidth(5); 

         break; 

      default: 

         break; 

    } 

} 

    Similarly, the setPenWidth method sets the pen's width to five different widths. 

QBrush is used for filling the shapes. This class has methods to set the color for filling the 

shape.  It also has different styles that fill a shape with different patterns. There about fifteen 

different style patterns this class supports. Some of them are Solid Fill pattern fills with uniform 

solid color, Diagonal pattern for diagonal style filling, and dense patterns for different density 

filling of shapes and so on. The following figure shows some of the pens styles and brush styles 

supported by Qt and OMSketch. 

 
 

    

void Tools::brush_color() 

{ 

        color=color_dialog->getColor(QColor(255,255,255),this);    

    if(color.isValid())         

    {                  

       brush.setColor(color);        
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scene->setBrush(brush);        

    } 

} 

The brush_color methods call a color dialog box. The same color object of QColorDialog is 

initialized to be white. Then it checks whether a valid color is selected. If the cancel button or ok 

button is clicked in a dialog box, then isValid () method is called and returns a Boolean accordingly. 

If an “ok” button is clicked a true value is return else a false is returned. Then the color is set to 

QBrush object. 
   

void Tools::setBrushStyles(int indx) 

  { 

         scene->setBrushStyle(indx); 

         switch(indx) 

           { 

       case 0: 

          brush.setStyle(Qt::NoBrush); 

           

          break; 

       case 1: 

          brush.setStyle(Qt::SolidPattern); 

          break; 

       case 2: 

          brush.setStyle(Qt::Dense1Pattern); 

          break; 

       case 3: 

          brush.setStyle(Qt::Dense2Pattern); 

          break; 

       case 4: 

          brush.setStyle(Qt::Dense3Pattern); 

          break; 

       case 5: 

          brush.setStyle(Qt::Dense4Pattern); 

          break; 

       case 6: 

          brush.setStyle(Qt::Dense5Pattern); 

          break; 

       case 7: 

          brush.setStyle(Qt::Dense6Pattern); 

          break; 

       case 8: 

          brush.setStyle(Qt::Dense7Pattern); 

          break; 

       case 9: 

          brush.setStyle(Qt::HorPattern); 

          break; 

       case 10: 

          brush.setStyle(Qt::VerPattern); 

          break; 

       case 11: 

          brush.setStyle(Qt::CrossPattern); 

          break; 

       case 12: 

          brush.setStyle(Qt::BDiagPattern); 

          break; 

       case 13: 

          brush.setStyle(Qt::FDiagPattern); 

          break; 

        

 

       case 14: 
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       brush.setStyle(Qt::DiagCrossPattern); 

          break; 

       default: 

          break; 

      } 

  } 

 

The setBrushStyles method sets the brush style of the pen it has about fourteen styles, and 

each style sets a different fill pattern in the shape. The fill patterns figure can be shown as follows. 

          

As said above every shape class has different methods to perform on the shapes. It has 

methods to set and get pen and brush styles. Every shape drawn is an item and this item is objected 

of QGraphicsPathItem class. This item has setters and getters for pen and brush styles. 

6.6 Managing the Shapes in Scene     

Although QGraphicsScene has methods to manage the scene contents the shapes. In 

OMSketch application shapes are managed by Scene_Objects class. It is like a template class that

              

manages all the shapes on the scene. Every shape in the scene is pushback into Scene_Objects list. 

The Scene_Objects class is structured as follows; the flow chart shows the methods and properties 

of Scene_Objects class. 

  
Figure 6.6 Scene Object Overview 

 

As seen from the above flow diagram every shape of a same kind is given a unique id. It 

also stores the index position of every shape from their respective lists. It also stores the starting and 

ending positions of a shape. It also stores the pen and brush attributes of every shape. This class has 

methods to check whether a shape on the scene is selected or not. The getObject method of this 

class is used for the checking a shape is selected or not. The code of the getObject function can be 

shown as follows. 

 
      int Scene_Objects::getObject(int &position) 

      { 

          if((ObjectStrtPnt.x()<=pnt.x())&&(ObjectEndPnt.x()>=pnt.x())&& 

             (ObjectStrtPnt.y()<=pnt.y())&&(ObjectEndPnt.y()>=pnt.y())) 
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            { 

              

             if(ObjectId==1) 

             { 

                position=ObjectPos; 

                return ObjectId; 

             } 

             if(ObjectId==2) 

             { 

                position=ObjectPos; 

                return ObjectId; 

           } 

 

           if(ObjectId==3) 

           { 

              position=ObjectPos; 

              return ObjectId; 

           } 

           if(ObjectId==4) 

           { 

              position=ObjectPos; 

              return ObjectId; 

            

           } 

         } 

     } 

The getObject method takes an integer reference argument as input. Then a check is 

performed whether the clicked point is within the shapes boundary. If the point is within boundary 

then, shape's index is copied into the input variable. The "ObjectPos" holds an index position of 

shape in its respective list. The ObjectId contains what type of object is selected, and it returns to 

the Scene_Graph object. For example, in the above method the ObjectId of one return a line is 

selected, two represents a rectangle is selected, similarly the same procedure for other shapes. 

 

Scene_Objects class methods are used in performing different actions in OMSketch 

application. Scene_Objects class is one the important classes of OMSketch application. 

Scene_Graph object maintains an array list of every shape on the scene. For example, the 

Draw_Rectangle object has listed rectangles, which holds all the rectangles on the scene. The 

pushing of rectangles into its list is performed in mouseReleaseEvent method. In the same method, 

the rectangle is also pushed into a list of a Scene_Objects object. The code for pushing of shapes 

into Scene_Objects class list can be shown as follows. 

 
Scene_Objects* object = new Scene_Objects(); 

       if(rect->getMode()==false) 

    { 

    oject->setObjects(2,rects.size()-1);       

    object->pen=rect->getPen();        

    object->setbrush(rect->getBrush());       

    object->rectangle=rect;         

    objects.push_back(object); 

     } 
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In the above code, "object" is a Scene_Objects object. Then the setObjects methods set 

the type of the object and the position of that object in the list (that is in rectangles list). Then the 

pen and brush of that shape are stored. The "object" is pushed into the list of Scene_Objects list. 

Storing the shape's data in this procedure reduces the search time in the shape’s list. The search 

procedure is as follows. First, the Scene_Objects list is checked using the method getObject. If the

              

shape is present, then the shape type and index of the shape in its list are returned. Taking this 

information the appropriate shape is selected on the scene. If there is no shape then the selected 

shape is to drawn is instantiated. The code can be shown as follows. 

 
             for(int i=0;i<objects.size();i++) 

     { 

        objects[i]->CheckPnt(strt_pnt); 

        k=objects[i]->getObject(position); 

 

     } 

          

           It searches for the shape in shape’s lists, and the position contains its list’s index and k 

contains the shape type. The shape type has information about a selected shape.     

 

6.6.1 Editing Shapes     

OMSketch gives full accesses to the users to edit the shapes. The edit operations such as 

resizing, rotating, and attributes such as colors and styles to the shapes can be set dynamically. 

When the user clicks on a particular shape two handle to appear on the edges for that shape. For 

shapes such as lines, rectangles, rounded rectangles and ellipse the two handles appears at some 

corners on the shape. Dragging these handles the user can resize the shape. On clicking on the 

shape the user can move the shape to some position on the scene. To select the shape the mouse left 

button is used when to click a check is performed internally. For example, if rounded rectangle is 

selected the two edge rectangles, and an ellipse appears. The appropriate rectangle is selected by 

making a check, whether the clicked point is in the particular rectangle. If present the particular task 

is performed. 

       

Editing polygons and polyline are a little bit different. For every edge of the polygon/line, a 

handle is added. The number of handles is equal to number of edges of a polygon/line. Dragging the 

handles the lines of polyline/polygon can be resized. The polygon/polyline can moved by left 

mouse click on the shape and drag to some position on the scene. The shapes styles and patterns can 

be set as disused in section 6.5. 
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Chapter 7 File Management   

OMSketch supports all the basic file management options such as new; Open, Save, Saveas, 

Export and Import File. The user can choose file options either from menu item or from the "Home" 

tabs file panel. The file panel contains the icons representing the action they perform. For example, 

the new file action is represented by new icon. The underlying Qt class for file management is 

QFileDialog [21]. This class has methods to open and save files. This class also has methods to 

filter out the files to be open or save. 

 

 
Figure 7 File Panel 

7.1 New File 

The New File option clears the entire drawing area. If there are any shapes present on the 

scene a dialog box pops up asking to save the present shape. When a new file option is clicked all 

the shapes lists and Scene_Objects lists are cleared. 

 7.1.2 Open File 

In OMSketch, a file dialog box appears when the open file option or icon is clicked. This file 

dialog has different options that support different file formats. The OMSketch supports almost all 

graphical file formats like jpg, bmp, gif and svg etc. Once the file is opened its contents are set to 

appropriate function, and the shapes are drawn to the scene. The detail procedure how the file is 

read is discuses in the section 8.2. 

 7.1.3 Save and Saveas File 

Save and Saveas options are almost the same. The Saveas option saves already saved file 

with a new name. The saved files are of standard formats as said above. However, saving procedure 

of files is different from other graphical editors. 

 7.1.4 Saving Shapes          

            For saving the shapes QImage [35] object is used. This object takes QPainter [19] object as 

constructor argument. The dimensions of an image are set from shapes coordinates. That is the 

coordinates of all the shapes on the scene is taken, and a maximum coordinate is taken and set as 

image dimensions. QPainter object methods are used for saving the shapes as the images. QPainter 

object is a low-level drawing object, performs painting or drawing on the widgets. As said in the 

section 6.6 the dynamic array list of scene shapes is maintained by the Scene_Objects class object. 

This array contains all the shape’s references that are present on the scene. QPainter object item is
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created, and this object has all the methods for drawing shapes such as lines, rectangles, ellipses, 

curves.  
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Chapter 8 Editing OMSketch Images 

8.1 Writing Images 

           When a scene is saved every shape is redrawn with all its attributes as an image. The QImage 

class methods are used for saving the shapes as images into different file formats [48]. In addition 

to saving the shapes as images, the shape properties and attributes are also saved to an image. 

QImage class has a method to store text. Usually, the text is used for saving information such as 

author, date, etc. This information is saved using user defined key words. For example, to save a 

author name the key word can be Author, and text is the author name. When reading the image the 

key word is passed to get back the text associated with it. OMSketch uses this property to save all 

the shape’s properties and attributes. For example, if a rectangle is saved, then a rectangle 

coordinates, pen color, pen style, pen width, brush color and brush style are also saved. These 

attributes of a rectangle are converted into a string and saved into image using the text method with 

key word “Sketch". The code for saving the shapes can be shown as follows. 

 
       QRgb rgb; 

         QPointF minPos,maxPos; 

        objectsPos.clear(); 

         QString text = QString(); 

         QString str_x,str_y,str_x1,str_y1; 

         QString color_r,color_g,color_b; 

         scene->getObjectsPos(objectsPos); 

         scene->getMinPosition(minPos); 

          scene->getMaxPosition(maxPos); 

This part of the code gets the minimum and maximum coordinates among all the shapes on 

the scene. The methods used are getMinPosition and getMaxPosition. 

          int p_r,p_g,p_b,p_style,p_width,b_r,b_g,b_b,b_style; 

          QPointF pnt,pnt1;        

    QImage *image = new QImage(scene->getDim().x()+3,    

                    scene->getDim().y()+3,                                            

    QImage::Format_ARGB32_Premultiplied); 

          image->fill(qRgb(255,255,255)); 

          QPainter *p = new Qpainter(image); 

     Then a QImage class object "image" is initialized with dimensions. The dimensions are the 

minimum and maximum of the shapes as discussed above. Then plus one is added to get the image 

dimensions. Then a constant is passed that per multiplies with 32 bits ARGB format. The   image is 

filled with a white color. This is the back ground of the image. This image object is passed into 

QPainter object as a constructor argument. 

    for(int i=0;i<scene->getObjects().size();i++) 

    { 

       if(scene->getObjects().at(i)->ObjectId==2) 

       { 
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           p_r=scene->getObjects().at(i)->getpen().color().red(); 

            

           p_g=scene->getObjects().at(i)->getpen().color().green(); 

           p_b=scene->getObjects().at(i)->getpen().color().blue(); 

           p_style=scene->getObjects().at(i)->getpen().style(); 

           p_width=scene->getObjects().at(i)->getpen().width(); 

           QPen pen1=p->pen(); 

           pen1.setColor(scene->getObjects().at(i)->getpen().color()); 

           pen1.setStyle(scene->getObjects().at(i)->getpen().style()); 

           pen1.setWidth(scene->getObjects().at(i)->getpen().width()); 

           p->setPen(pen1); 

            

     In this code, the process of saving a rectangle is illustrated. The objectId is for a rectangle. 

The above variables p_r, p_g, p_b to store the shape's pen colors RGB values. The p_style and 

p_width to store shape's pen style and width. Then a temporary QPen object is created, and these 

variables are set to their respective properties. Then the pen is set to the painter’s setPen method. 

           b_r=scene->getObjects().at(i)->getbrush().color().red(); 

           b_g=scene->getObjects().at(i)->getbrush().color().green(); 

           b_b=scene->getObjects().at(i)->getbrush().color().blue(); 

           b_style=scene->getObjects().at(i)->getbrush().style(); 

           QBrush brush1=p->brush(); 

           brush1.setColor(scene->getObjects().at(i)->getbrush().color()); 

           brush1.setStyle(scene->getObjects().at(i)->getbrush().style()); 

           p->setBrush(brush1); 

    Similarly, the shapes brush color and styles are copied into b_r, b_g, b_b and b_style variables 

respectively. Then a temporary QBrush objet is created and to this object, the variables are set 

according to their properties. The brush1 variable is set to the painter's setBrush method. 

p->drawRect(scene->getObjects().at(i)->ObjectStrtPnt.x(),    

  scene->getObjects().at(i)->ObjectStrtPnt.y(),      

scene->getObjects().at(i)->ObjectEndPnt.x()-scene-            

>getObjects().at(i)->ObjectStrtPnt.x(),scene->getObjects().at(i)-            

>ObjectEndPnt.y()-scene->getObjects().at(i)->ObjectStrtPnt.y()); 

  

The method drawRect takes the shapes starting and ending points and draws the rectangle. 

The points are supplied by the Graph_Scene object’s position. These objects are shapes starting and 

ending points.   
    
 

           text+="Rectangle\n"; 

          text+="Coords"; 

          text+=" "+str_x.setNum(4); 

          text+=" "+str_x.setNum((scene->getObjects().at(i)-    
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ObjectStrtPnt.x()))+" "+str_y.setNum((scene->getObjects().at(i)-          

>ObjectStrtPnt.y()))+" "+str_x1.setNum((scene->getObjects().at(i)-          

>ObjectEndPnt.x()))+" "+str_y1.setNum((scene->getObjects().at(i) 

          ->ObjectEndPnt.y()))+"\n"; 

           

          text+="PenColor"; 

          text+=" "+color_r.setNum(p_r)+" "+color_g.setNum(p_g)+" 

          "+color_b.setNum(p_b)+"\n"; 

          text+="PenStyle"; 

          text+=" "+color_r.setNum(p_style)+"\n"; 

          text+="PenWidth"; 

          text+=" "+color_r.setNum(p_width)+"\n"; 

          text+="BrushColor"; 

          text+=" "+color_r.setNum(b_r)+" "+color_g.setNum(b_g)+" 

          "+color_b.setNum(b_b)+"\n"; 

           text+="BrushStyle"; 

           text+=" "+color_r.setNum(b_style)+"\n"; 

           update(); 

       } 

       p->end(); 

     

 

      // Save it.. 

      image->setText("Sketch",text); 

      image->save(fileName,"PNG"); 

} 

Then a string variable "text" is stored with the combination of special key words and 

shapes attributes. So every text starts with the type of shape. In this code, the text starts with the 

"Rectangle" key word. Then another key word follows "Coords" then the shapes starting and 

ending points are converted to text and added to the "text" variable. Then the key words 

PenColor, PenStyle, PenWidth, BrushColor and BrushStyle are added followed by their respective 

properties from the shape. If another object is to be added the same procedure is followed, but a 

space is added after the completion of each shape. Then this string "text" variable is passed into 

the QImage setText method as one argument and other being the key word to recognize the text. 

Then the image is saved to the desired file format. In this code, it is saved as png and bmp file. 

 

8.2 Reading Images 

If an image is open in OMSketch, the file name is passed as an argument to QImageReader 

object. This object has a method that can retrieve the text present in the image. In this case, we pass 

the "Sketch” key word and get back the relative text. If it is not empty, then the text is passed to 

Sketch_Files object. This object has methods to parse the text. The text is converting back to 

integers and passed to an array of Scene_Object instance. This Scene_Object instance array passes 

the shapes to appropriate shape item object and adds them to the scene. Once they are added to the 

scene they are converted from image to graphical items. If the text return is null, then the image is 

passed to QPixMap [36] instance, further this is added to the scene.  The code to illustrate the above 

procedure can be shown as follows. 
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         QTextStream readline;           

    QString subText; 

    bool ok; 

    if(text.contains("Sketch:")) 

        text.remove("Sketch:"); 

    readline.setString(&text,QIODevice::ReadWrite); 

    while(!readline.atEnd()) 

    { 

        readline>>subText; 

         

        if(subText.contains("Rectangle")) 

        { 

            values.push_back(2); 

        } 

 

        if(subText.contains("Ellipse")) 

        { 

            values.push_back(3); 

        } 

    } 

 

The above code takes the text that is discussed in the previous section. First, the text is 

searched for Sketch string; if the string is present, then it is removed. An object of QTextStream is 

created. The text is set as in put to QTextStream through setString method. A while loop is run until 

the end of the text is reached. QString variable is created; into this, the text sub texts are read. Each 

sub text is checked for the key words. In the above code, a check is performed for Rectangle and 

Ellipse. If either of them is contained in sub text, then the ObjectId is pushed back into an integer 

list, here the integer’s list is hold by the variable values. 
 

if((!subText.contains("Coords"))&&(!subText.contains("Line"))&&(! 

subText.contains("Rectangle"))&&(!subText.contains("Ellipse"))&&(! 

subText.contains("Polygon"))&&(!subText.contains("RoundRect"))&&(! 

subText.contains("Arc"))&&(!subText.contains("PenColor"))&&(! 

subText.contains("PenStyle")&&(!subText.contains("PenWidth"))&&(! 

subText.contains("BrushColor"))&&(!subText.contains("BrushStyle")))) 

{ 

values.push_back(subText.toInt(&ok,10)); 

} 

 

Then the sub text is checked for all the key words in the text, and they all are pushed back 

into the "values" list.  So the "values" integer list contains all the properties of a shape in a 

systematic order.  

 

Once the whole text is parsed and added to the values list. The "values" are returned to the 

main method and passed into the Graph_Scene. Once the values are passed into Graph_Scene 

through Open_Scene method, values are re-parsed to their respective shape classes.  For the 

standard shapes like lines, rectangles etc., the loop is iterated for very sixteen values. That is after 

every sixteenth value a new shape is started in the loop. The following code shows how the values 

are parsed for four point’s shapes like rectangle, etc. 

 
   for(int i=0;i<values.size();) 
    { 

        if(values[i]!=4 && values[i+1]==4) 

        { 

           Scene_Objects* object = new Scene_Objects(); 

           qDebug()<<"entered "<<"\n"; 

           object->ObjectId=values[i]; 

           object->ObjectStrtPnt.setX(values[i+2]); 

           object->ObjectStrtPnt.setY(values[i+3]); 
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           object->ObjectEndPnt.setX(values[i+4]); 

           object->ObjectEndPnt.setY(values[i+5]); 

           object->setPenColor(values[i+6],values[i+7],values[i+8]); 

           object->setPenStyle(values[i+9]); 

           object->setPenWidth(values[i+10]); 

           object->setBrushColor(values[i+11],values[i+12],values[i+13]); 

           object->setBrushStyle(values[i+14]); 

           objects.push_back(object); 

           i+=15; 

        } 

  

The first value in the list contains the Id of the shape.  Next values are coordinated of the 

shape, after they are stored the next values in a list PenColor, PenStyle, PenWidth, BrushColor and 

BrushStyle. These values are stored into a Scene_Objects class list. 
 
        

if(i==values.size()) 

       { 

            break; 

       } 

        if(values[i]==4) 

        { 

           object->ObjectId=values[i]; 

           int j; 

           if(i==0) 

           { 

              j=values[i+1]; 

           } 

           if(i!=0) 

           { 

              j=values[i+1]; 

              j=j+i; 

           } 

           for(i=i+2;i<j+2;i+=2) 

           { 

               QPointF pnt(values[i],values[i+1]); 

               object->pnts.push_back(pnt); 

             } 

             j=i; 

             object->setPenColor(values[j],values[j+1],values[j+2]); 

             object->setPenStyle(values[j+3]); 

             object->setPenWidth(values[j+4]); 

             object->setBrushColor(values[j+5],values[j+6],values[j+7]); 

             object->setBrushStyle(values[j+8]); 

             objects.push_back(object); 

             i=j+9; 

        } 

For shapes which have more than four edges, for example, polygon. The number of points 

that make it may exceed four or below four. It can be any number of points. So when storing the 

shape the number of points or coordinates is also stored. Parsing out the value of second position in 

the list gives number of coordinates of the shape. A new loop run until this value is reached. The 

loop is incremented twice for every iteration. Two values are read and push back into objects 

pnt’s list. Remaining values are read after as discussed in pervious code.         
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8.3 Cut, Copy and Paste 

OMSketch can cut copy and paste operations to perform on the shapes. These operations can 

be selected from the "Home" tab under "Edit" panel or from the file menu under "Edit” option. The 

cut, copy and paste operations can be performed on a single shape or multiple shapes. 

In order to select multiple shapes, the control key should be pressed, and the mouse can be use to 

select multiple shapes. The appropriate option can be chosen like cut or copy, and the object can be 

paste back to the scene. 

8.3.1 Copy and Cut   

The procedure for copy and cut are almost the same. When the shapes are cut, they are 

completely removed or deleted from the scene. Whereas when a copy operation is performed the 

selected shapes are not deleted, but a temporary copy is done. In order to perform these operations 

in OMSketch a temporary Scene_Object's dynamic array is created. 
 

       if(event->key()==Qt::Key_Control)          

      { 
      scene->isMultipleSelected=true; 

  } 
 

When a controlled key is pressed a Boolean variable is enabled stating the control key is 

pressed. Then multiple shapes can be selected. Every shape selected can be visually seen as their 

start, end and rotation handles are visible. This can be shown as follows. 
 

       

          copy_objects.clear(); 

    if(!objects.isEmpty()) 

    { 

      for(int i=0;i<objects.size();i++) 

      { 

        if(objects[i]->ObjectId==1) 

        { 

           for(int j=0;j<lines.size();j++) 

           { 

               if(objects[i]->ObjectStrtPnt==lines[j]->getStartPnt()) 

               { 

                  if(lines[j]->Strt_Rect->isVisible()) 

                  { 

                     Scene_Objects* object = new Scene_Objects();    

                object=objects[i];       

         object->ObjectId=1; 

                     object->ObjectIndx=j; 

                     object->setpen(lines[j]->getPen()); 

                     copy_objects.push_back(object); 

                  } 

               } 

           } 

        } 
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Once all the shapes are selected for copying, then the above procedure is followed. First, the 

copy_objects list is cleared and ready to push shapes into it. A check is made to whether a shape is 

selected for copying. In the check process, the shapes reshaping rectangle visibility is checked. If 

visible than the shapes are added copy_objects list. 
 

          isCopySelected=true; 

    temp_copy_objects.clear(); 

    temp_copy_objects.reserve(copy_objects.size()); 

    for(int i=0;i<copy_objects.size();i++) 

    { 

        Scene_Objects *temp_object = new Scene_Objects(); 

        temp_object=copy_objects[i]; 

        temp_object->ObjectId=copy_objects[i]->ObjectId; 

        temp_copy_objects.insert(i,temp_object); 

    } 

    copy_objects.clear(); 

 

Then these copy_objects lists are recopied into another list temp_copy_objects, and paste is 

performed on it. The reason for a copy into temp_copy_objects is used for re-use. 
 

For cutting the shapes the first two steps are same that is selecting of shapes and copying the 

shapes into new lists. 
 

    if(!temp_copy_objects.isEmpty()) 

    { 

        QVector<Draw_Arc*> arcs1; 

        QVector<Draw_Line*> lines1; 

        QVector<Draw_Rectangle*> rects1; 

        QVector<Draw_RoundRect*> round_rects1; 

        QVector<Draw_Ellipse*> elleps1; 

        QVector<Draw_Polygon*> polys1; 

        arcs1=arcs; 

        lines1=lines; 

        rects1=rects; 

        round_rects1=round_rects; 

        polys1=polygons; 

    for(int i=0;i<temp_copy_objects.size();i++) 

    { 

      if(temp_copy_objects[i]->ObjectId==1) 

      { 

          for(int j=0;j<lines.size();j++) 

          { 

             if(lines[j]->getStartPnt()==temp_copy_objects[i]->ObjectStrtPnt) 

             { 

                  removeItem(lines[j]->item); 

                  removeItem(lines[j]->Strt_Rect); 

                  removeItem(lines[j]->End_Rect); 

                  removeItem(lines[j]->Rot_Rect); 

              } 

           } 

      } 

     } 

    } 

 

First, the temporary object’s lists are checked such that it is not empty. Then temporary lists 

of all the shapes are instantiated. Then from temp_copy_objects lists what shapes are present is 

checked. That is depending upon object’s id the points are checked in their respective lists, and they 

are removed.  In the above code, the numbers of line shapes are checked and removed.   
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8.3.2 Paste 

When a paste operation is performed the shapes from the temporary array are drawn back to 

the scene. When the shapes are added to the scene, the shape’s attributes are updated to their 

respective arrays. The temporary array is copied to a new array to perform recursive paste 

operation. When a new shape is select to draw the temporary array and paste temporary arrays are 

cleared. 
            

          paste_selected_objects.clear(); 

    if((!temp_copy_objects.isEmpty())) 

    { 

        

       for(int i=0;i<temp_copy_objects.size();i++) 

       { 

           Scene_Objects *object =  new Scene_Objects(); 

           Draw_Line *line2 = new Draw_Line(); 

            

           if(temp_copy_objects[i]->ObjectId==1) 

           { 

              line2->setStartPoint(temp_copy_objects[i]->ObjectStrtPnt); 

               

              line2->setEndPoint(temp_copy_objects[i]->ObjectEndPnt); 

              line2->setState(0); 

              line2->setMode(true); 

              line2->item =  new QGraphicsPathItem                                              

    (line2->getLine(temp_copy_objects[i]->ObjectEndPnt)); 

              if(isCopySelected) 

              { 

                 line2->setTranslate(QPointF(5,5),QPointF(20,20)); 

                 line2->item->setPath(line2->getLine(line2->getEndPnt())); 

              } 

              line2->setPen(temp_copy_objects[i]->getpen().color()); 

              line2->setPenStyle(temp_copy_objects[i]->getpen().style()); 

              line2->setPenWidth(temp_copy_objects[i]->getpen().width()); 

              addItem(line2->item); 

              line2->setEdgeRects(); 

              addItem(line2->Strt_Rect); 

              addItem(line2->End_Rect); 

              addItem(line2->Rot_Rect); 

              lines.push_back(line2); 

              object->ObjectId=1; 

              object->setObjectPos(line2->getStartPnt(),line2->getEndPnt()); 

              object->setpen(line2->getPen()); 

              object->setObjects(1,lines.size()-1); 

              object->ObjectIndx=lines.size()-1; 

              objects.push_back(object); 

              paste_selected_objects.push_back(object); 

           } 

     } 

} 

 

When the copy or cut operations are chosen the shapes are copied into a temporary list. This 

list is used when they are pasted back on the scene. Every shape is instantiated, and shapes in the 

list are copied to their respective lists. Then they are added back to the list. The copy shapes when 

pasted they are bits translated from original shape. This is because it gives a clear view of shapes 
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pasted, and also easy to select them. The above code shows an example how a line pasted back into 

the scene. The Scene_Objects and Draw_Line objects are created. Then the shapes in 

temp_copy_objects are copied into the lines and object’s shapes and also added to the scene. The 

following figure shows the copying of shapes. 

8.4 Exporting and Importing Images 

The main purpose of OMSketch application is to embed drawn shapes into OMNotebook 

document and also edit the images of OMNotebook document. The process of embedding the 

OMSketch shapes into OMNotebook document is performing by exporting action. Importing action 

edit the OMNotebook document shapes into OMSketch editor. When an export option is chooses in 

OMSketch, the image is exported to OMNotebook document current cursor position. The importing 

action is performed from OMNotebook document. The image at the current cursor position in 

OMNotebook document can be exported to OMSketch by pressing a short cut on key board, which 

is an importing action of OMSketch. 

8.4.1 Exporting Image   

Before exporting the image to OMNotebook document the selected shape or shapes in 

OMSketch editor are written to an image with a temporary name. This image is converted into a 

              

character with a special Unicode to recognize it. QTextImageFormat class is used for this 

conversion. This class converts the image as a single character assigns a Unicode to it, and then this 

character is embedded into the OMNotebook document editor. In order to convert the image as a 

character the size of the image and size of the image is set with the QTextImageFormat methods.  

The following code illustrates the usage of QTextImageFormat class in OMSketch application. 

 
                       QTextEdit *editor = new QTextEdit(); 
    QTextImageFormat imageformat; 

    QTextCursor cursor = document->getCursor()->currentCell()   

        ->textCursor(); 

     if(!cursor.isNull()) 

     { 

    QString imagename="sketch_"; 

    imagename=imagename+num.setNum(filenames.size()+1,10)+".png"; 

    images.imageName=imagename; 

        filenames.push_back(imagename); 

    images.text=text; 

    writeImage(images); 

    imagefilenames.push_back(imagename); 

           editor = document->getCursor()->currentCell()->textEdit(); 

 

       First objects are initialized; they are QTextEdit, QTextImageFormat and QTextCursor. The 

present text cursor of OMNotebook document is stored into a cursor variable. Then a check is 

performed on cursor variable to check if it is not null. Then a string with a temporary name is 

initialized, and it is appended with the current select image number from an array. Every selected 

image that is to be exported into OMNotebook document is pushed into a temporary list, and the list 

index is used as a temporary name of the image. Then the current cell text edits a reference is stored 

into the editor variable of QTextEdit. 
 

       if( editor ) 
       { 

    // save text settings and set them after image have been inserted 

        QTextCharFormat format = cursor.charFormat(); 

      if( editor->toPlainText().isEmpty() ) 
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                 format = *document->getCursor()->currentCell()->style()   

       ->textCharFormat(); 

                    

      imageformat.merge( format ); 

      imageformat.setHeight( images.image->height()); 

         imageformat.setWidth( images.image->width()); 

      imageformat.setName( images.imageName ); 

      cursor.insertImage( imageformat ); 

         } 

   

         } 

The current cursor format of OMNotebook document cell is copied into a variable of 

QTextCharFormat object. This object can manage different formats of the cell, and this format is 

merged with the QTextImageFormat object instance imageformat and this instance is set with the 

properties of image that is to be exported to OMNotebook document.                                  

8.4.2 Importing Image 

Images embed using OMSketch into OMNotebook document can be edit back. As said 

above QTextImageFormat object is used to check whether the character at the present cursor is an 

image or not. Using the methods of this object the image is exported into OMSketch editor. As 

mentioned in a section number writing the images. The image contains information about attributes 

such as image type, color, style, etc. These values are read, and the images are pushed back into the 

respective shape arrays. The images are converting back to shapes. 
 
             

            QTextCharFormat format = document->getCursor()->currentCell()   

      ->textCursor().charFormat(); 
 

       image_info img; 

 

       //checks for image at that cursor position 

        if(format.objectType()==1) 

  { 

       QTextImageFormat format1 = format.toImageFormat(); 

       QString imagename=format1.name(); 

  } 

 

When the shape edit in the OMNotebook document the following procedure takes place. 

The format at the current cursor is stored into "format" an object of QTextCharFormat object. Then 

a check is performing whether an object cursor format is an image or not. The format is converted 

into image type and store into QTextImageFormat object "format1”. Then the image name is 

retrieved and store into a string variable. 
 

//editing  an image from saved file, that is when an open file option is used choosed in 

OMNotebook document 

  if(imagename.contains("file:///")) 

  { 

                QImage *image=document->getImage(imagename);   

                imagename.remove( "file:///" ); 

     file_name=imagename; 

     onb_file_name=document->getFilename(); 

     img.imageName=imagename; 

     img.image=image; 

     edit_imgs_info.push_back(img); 

           

      imageinfo(imagename); 

     edit=true; 

  } 
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The string is checked if it contains "file:///" then the image reference is stored into QImage 

object. Then the unnecessary paths are removing from the path and send into image info method. In 

this method, the image is read using QReadImage object. This object processes the attributes of 

image. The process is explained in detail in the section number. 
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Chapter 9 Results 

 This section present results of the OMSketch editor. This chapter presents some of the 

shapes their attributes and properties. The shape handles and the resizing, translation and rotation of 

shapes. It also shows widgets used for setting the color and how the shape is exported to 

OMNotebook document and edit a shape from OMNotebook document to OMSketch editor. 

9.1 OMSketch Application Layouts 

 

 
Figure 9.1 OMSketch Main Layouts 

 

     The above Figure 9.1 shows the main layout of OMSketch application. It contains widgets to 

handle different events. It has menu, toolbar, tab widget and a drawing area. 
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9.2 Shapes 

 
Figure 9.2 Shapes of OMSketch 

 

  Figure 9.2 shows some of the shapes supported by OMSketch application. It contains rectangle, 

polygon, arrow, ellipse and a triangle.   

9.3 Shape Handles 

 
Figure 9.3 Shape Handles 

 

The above Figure 9.3 shows the handles of shape used for resize and rotate.  
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9.4 Resizing of Shapes 

 
Figure 9.4 Shape Resizing 

 

Figure 9.4 shows the resized shape. The first image is an original shape and the second shape is 

resized shape. 

9.5 Translation of Shape 

 

 
Figure 9.5 Shape Translation 

 

The above Figure 9.5 shows the translation of the first shape to some point in the scene. 
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9.6 Rotation of a Shape 

 
Figure 9.6 Shape Rotation 

 

The above Figure 9.6 illustrates the rotation of the shape.   

9.7 Shapes drawn with different pen Colors & Widths and Styles 

 

 
Figure 9.7 Shape Pen Color, Width and Styles 

 

Figure 9.7 shows different pen colors, widths and styles. 

9.8 Shapes drawn with different brush and fill styles 

 
 

Figure 9.8 Shape Brush Color and Fill Patterns 
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Figure 9.8 shows different brush colors and fills styles. 

9.9 Shapes Copy 

 
Figure 9.9 Copied Shapes 

The Figure 9.9 illustrates the copied shapes. The arrow and triangle copied shapes. 
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9.10 Shapes Exported OMNotebook document 

 
Figure 9.10 Exported Shapes 

 

Figure 9.10 shows an export from OMSketch to OMNotebook document.  

 

9.11 Shapes edited from OMNotebook document 

Figure 9.11 Editing a shape from OMNotebook document to OMSketch 
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9.12 Edited OMNotebook document Shape 

 

 
Figure 9.12 Edit Shape of OMNotebook document 

 

Figure 9.11 shows the shapes in OMNotebook document. Figure 9.12 shows the same image edited 

back in OMSketch editor. 
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Conclusion 

  OMSketch is an advanced graphical editor to OMNotebook document.  It is a cross platform 

application currently supported on Windows and Linux environments. This editor provides rich 

GUI components that elevate the user interaction, shapes and their properties, save and open and 

exporting and importing of shapes.  

 

 The OMSketch GUI Components and its functions use Qt Trolltech libraries. It provides 

different GUI components; make the interaction and usage very effective. The menu bar contains 

file and edit menus. These menus contain different file and edit options. The toolbar provides the 

shape icons; by clicking on the icons a shape is select for drawing. Tool tips will appear, when the 

mouse is moved on the components. The tab widget contains panels providing different clickable 

icons, spin box and combo boxes. By clicking these icons according to the panels, different actions 

are performed. File dialogs are provided to open and save the shapes from and to disk.  It also 

provides the color dialog to select the pen and brush color for the shapes. Message boxes are also 

provided. It provides a drawing area to draw and manipulate shapes.     

   

The editor provides ten types of shapes and some of them are Lines, Rectangles, Rounded 

Rectangles, Ellipses and Polygons, etc. Shapes can be transformed, rotate and resize dynamically.  

The shapes can be set with properties like colors, pens and filling styles. These properties can be 

chosen from the tab widget. Multiple or group of shapes can be selected by holding the control 

button and clicking on the shape. The shapes can be copied, cut and paste. These operations can be 

performed on single shape or on multiple or group of shapes.  

 

Shapes can be saved into two file formats such as bmp, png etc. When saving a shape to a 

file format the shape’s attributes such as coordinates, colors and styles are also saved using some 

methods. This feature makes it possible to open the shapes and edit them. The shapes can be 

exported into OMNotebook document and also import from OMNotebook document. OMSketch is 

a well designed graphical editor. 

 

It enhances the OMNotebook document’s features by providing the shapes into the 

exercises.  The students and users can draw shapes they need as per their requirement and insert 

them. By this way the students, users can prepare graphical notes that make better understanding of 

the exercises. It helps teachers to interactively teach the exercises to the students. The editor also 

provides to update the shapes to fit the current situation.      
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Future Work 

  OMSketch is a graphical editor that supports many shapes. The current OMSketch 

application supports limited number of shapes, around ten of them. A larger selection of shape types 

can be implemented. The present Scene_Object class has methods to store the shape and its 

properties. Further, this class can implement methods that store the screen coordinates.  

A Quad-Tree data structure can be also implemented in Scene_Object class. By 

implementing this method, the drawing area is divided into four equal division recursively until 

some threshold screen coordinates value. Then the shape screen coordinates are stored into the 

division that is greater than shape coordinates. While selecting a shape, a search is performed 

relative to shape coordinates and the division the shape is stored. This process reduces the search 

time and makes application more efficient. 

 

The tab widget has only one tab contain different panels to perform different actions. More 

tabs can be added with more options. New tab "Shapes" can be added that can be paneled into 

standard shapes, non-standard shapes, curves, etc. A tab for text can be also added that contains 

different text attributes such as fonts, text size, color, etc.   

 

The current version of this application saves the shapes as png and bmp. The option can be 

extended to save files such as svg and mo. The export operation embeds the shape into 

OMNotebook document. A new option for export can be added that exports the current shapes as 

models for Modelica. The same way the import of a model can also be implemented. 
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APPENDIX A 

Starting with OMNotebook 

Steps to Compile OMNotebook in VS 2010 with QT 4.7(qt-everywhere-opensource-src-4.7.0-
beta2) 
Following is a description how to compile OMNotebook in Visual Studio. The folder names can 

be selected according to one’s own choice. 

 

1) Download the source code from OpenModelica.org under OpenModelicaDocs folder. 

Following link is for windows user. 

http://openmodelica.org/index.php/download/download-windows 

 

Linux and Mac can also be selected from the Download menu in the website 

www.openmodelica.org. 

 

2) Download OpenModelicaLibs from the following link:    

             http://www.ida.liu.se/~adrpo/omc/omdev/qtlibs/.  

 

3) OpenModelicaLibs directory contains(coin3d, qt-everywhere-opensource-src-4.7.0-beta2 

            and  soQt). Download the zipped file under openModelicaDocs folder and unzip it. 

 

4) Open the project OMNotebook.vcxproj in visual studio ultimate 2010. 

If you have the same folder names as used in this document then you can find 

OMNotebook.vcxproj under the folder: 

C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4 

Before compiling we have to set the following “system” paths: 
Under advanced system setting go to environment variables and set the paths for the user 

variables: 

Give the paths (Variable Value) according to your system path where these files are be located: 

 

Variable name   Variable Value 

COINDIR C: \OpenModelicaDocs \OpenModelicaLibs\coin3d 

DRMODELICAHOME "C:\OpenModelica1.5.0\DrModelica 

OMDEV C:\OMDev 

OPENMODELICAHOME C:\OpenModelica1.5.0\ 

OPENMODELICALIBRARY C:\OpenModelica1.5.0\ModelicaLibrary 

QNBHOME C:\OpenModelicaDocs\OM_Source_Code\OMNotebook 

 

QTHOME C:\OpenModelicaDocs\OpenModelicaLibs\qt-everywhere-

opensource-src-4.7.0-beta2 \ 

http://openmodelica.org/index.php/download/download-windows
http://www.openmodelica.org/
http://www.ida.liu.se/~adrpo/omc/omdev/qtlibs/
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In visual studio ultimate 2010: 

Solution / Property Manager -> right click on OMNotebookQT4 -> Properties -> Configuration 

Properties 

 

 C/C++ ->General -> Additional Include Directories. 

 All these paths should be included. 

 

1) $(QNBHOME)\NotebookParser 

2) $(OMDEV)\include\mico-win32-msvc 

3) $(OMDEV)\include 

4) $(QTHOME)\include 

5) $(QTHOME)\include\QTGui 

6) $(QTHOME)\include\QTCore 

7) $(QTHOME)\mkspecs\win32-msvc2010 

8) $(COINDIR)\include 

9) $(ProjectDir) 

 

 Linker ->General ->Output File should be $(Configuration)\OMNotebook.exe 

     ->Additional Library Directories.You will have these paths: 

 

1) ..\3Dpkg\Release\ 

2) $(COINDIR)\lib\ 

3) $(OMDEV)\lib\mico-win32-msvc\ 

4)  ..\Pltpkg2\Release 

5)  $(QTHOME)\lib 

6)  $(OMDEV)\lib\antlr-win32-msvc\md-mdd\ 

7)  ..\NotebookParser\Release 

 

 Linker ->Input ->Additional Dependencies.Following “dll” files has to be set. 

 

1) qtmain.lib 

2) QtGui4.lib 

3) QtNetwork4.lib 

4) QtXml4.lib 

5) NotebookParser.lib 

6) antlr.lib 

7) mico2313.lib 

8) QtCore4.lib 

9) QtOpenGL4.lib 

10) pltpkg2.lib 

11) ws2_32.lib 

12) imm32.lib 

13) winmm.lib 

14) coin3.lib 

15) soqt1.lib 
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Compiling in Release mode with win32:- 

If you will get antlr.lib file errors that is which it will not found, following steps should be 

followed: 

Click or go to visual studio command prompt under Tools Menu in visual Studio 2010. 

Go to the OMDev directory which is located (C:\OMDev). Execute following commands 

 

 C:\OMDev\lib\antlr-win32-msvc 

 nmake –f Makefile.win32 clean 

del /Q .obj antlr.lib .idb .pdb 

 nmake –f Makefile.win32 

1 file(s) moved. 

 cd md-mdd 

 nmake –f Makefile.win32 clean 

 nmake –f Makefile.win32 

 copy the files omc_communication.h and omc_communication.cc files into              

OMNotebookQT4 project under the folder: 

C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4 
 omc_communication.h and omc_communication.cc will be generated automatically. For 

generating these files go to msys.bat under the folder: 

C:\OMDev\tools\msys 
 Double click msys.bat. You will get the command prompt, if writing cannot be performed  

on the command prompt then close and double click msys.bat again. Run the following 

commands: 

1) cd OpenModelica 

2) cd OpenModelicaDocs/OM_Source_Code 

(The purpose of above two commands is to reach the folder where you have downloaded 

the source code from openmodelica.org. Therefore select the folder where you have the 

source code downloaded). Then run the following commands 

1) make –f Makefile.omdev mingw clean 

2) make –f Makefile.omdev mingw 

 After running the above two commands you can search for omc_communication.h and 

omc_communication.cc files in C:\OpenModelicaDocs\OM_Source_Code folder or in 

C:\OpenModelicaDocs\OM_Source_Code\Compiler folder. 

 Copy and paste the files (omc_communication.h and omc_communication.cc) under the 

folder: C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4 if not  

already done. 

 Open the Visual Studio project and go to: 

o Project Pltpkg2 ->Source Files -> 

Right click on moc_compoundWidget.cpp and change the properties for first 

moc_compoundWidget.cpp which is Excluded from Build as No 

o Change the properties for the second moc_compoundWidget.cpp which is Excluded 

  from Build as Yes 

o OMNotebook QT4 properties->code generation in C/C++ change the Floating Point 

 Model as No [i.e Precise (/fp:precise)] 
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1. Copy all QT .dll files from Qt directory which is located under OpenModelicaLibs: 
C:\OpenModelicaDocs\OpenModelicaLibs\qt-everywhere-opensource-src-4.7.0- 
beta2\lib 
And paste it to: 

C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4\Debug 
C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4\Release 

2. Copy the soqt1 .dll file from the following link: 
C:\OpenModelicaDocs\OpenModelicaLibs\soQt\build\msvc8 
And paste to: 

C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4\Debug 
C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4\Release 

3. Copy the .lib files(coin3.lib and soqt1.lib) from the following link/directory: 
C:\OpenModelicaDocs\OpenModelicaLibs\coin3d\lib 
And paste it to: 

C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4\Debug 
C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4\Release 

4. Copy the commands.xml, modelicacolors.xml and stylesheet.xml from [  
C:\OpenModelica1.5.0\bin] into 

C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4\Debug 
C:\OpenModelicaDocs\OM_Source_Code\OMNotebook\OMNotebookQT4\Release 

Some Common Errors 
 

1. If you are getting an error of missing some mico2313.dll perform the following steps: 

i) Download the complete source for mico from http://mico.org/down.html 

ii) Open the visual studio prompt and go to mico directory where it is located and execute 

the               command.   

iii) nmake –f Makefile.win32 

iv) Copy the mico2313.dll and pthreadvc2.dll files from the folder. 

C:\OpenModelicaDocs\mico\win32-bin (depends upon where you have downloaded 

mico) and paste it in 

C:\OpenModelicaDocs\OM_Source_Code\OMNotebookdocument\OMNotebookQT4\De 
bug 
C:\OpenModelicaDocs\OM_Source_Code\OMNotebookdocument\OMNotebookQT4\Re 
lease 

1. If you are getting nmake problem, it means your command prompt is not recognizing 

nmake then go to visual studio 2010\common 7\Tools and then run vsvars32.bat file then 

your nmake will work. 

2. After compiling if Visual Studio generates an error of “OMNotebook.exe not 

found” then check the properties of OMNotebookQT4 and give 

OMNotebook -> Properties -> Configuration Properties -> General 
Output directory: Debug\ (check if it is in debug mode) 
Select Target Name: OMNotebook (instead of project name) 

3. If the OMNotebook is crashing after running once then delete the file openmodelica.objid 

file. 
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User Guide 

OMSketch is a graphical editor to OMNotebook.  Its main purpose is to provide shapes to 

OMNotebook and also to edit them. Starting the OMSketch application is done through clicking 

the paint icon in OMNotebook. Then a separate window is opened to draw and edit the shapes. 

The user guide can be given as follows. 

 

Application Layout 

 Application layout is the main layout of OMSketch application. Every action is 

performed through this layout. The layout consists of Menus, Toolbar, Tab Widget and a drawing 

area. 

 

Menu 

The menu consists of two main menu items they are File and Edit Items. The File menu 

consists of new, open, save, save as, export and import. The Edit menu contains the edit items 

cut, copy and paste.     

 

Toolbar 

  The toolbar consists of shapes icons. Each icon represents the shape. The users can select 

a shape by clicking on the shapes icon.  

 

Tab Widget 

 The Home tab widget contains panels. Each panel contains different options and it 

contains File, Edit, Color, Pen and Brush style panels. 

 

 File Panel 

The file contains the options such as new, open, save, save as, export and import. All the 

file operations can be select from this panel. All options are represented through appropriate 

icons. ToolTips are also added to show the purpose of the actions. 

 

Edit Panel 

The edit panel contains actions such as cut, copy and paste. These options are also 

represented through icons in the panel, tool tips are shown. 

 

Color and Styles Panel 

This panel contains widgets to specify or select colors and different styles to the shapes. 

Icons and tooltips are added to widgets to define the purpose of the widgets. 
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Drawing Area 

The main layout contains the drawing area to draw the shapes. The drawing area size is 

dynamically increased according to the shape drawn. Scrollbars are auto added to pan the entire 

view of the scene. 

 

Shapes 

The present OMSketch version supports ten types of shapes such as Rectangles, Rounded 

Rectangles, Ellipse, Poly Line, Polygon, Line Arrow, Arrow, arc and Triangle. 

 

Standard Shapes 

The standard shapes are Rectangle, Rounded Rectangle and Ellipse. These shapes can be 

select from the toolbar. The shapes are drawn dynamically. When drawing of shape is done 

handles will appear for the shape. With the help of handles shape can be resized and rotated. The 

shape can be translated by clicking on shape and moving to the desired location on the scene. 

 

Non Standard Shapes 

The non standard shapes are Poly Line and Polygon and other as mentioned above. The 

poly line has more number of lines that can be drawn until the mouse is double clicked. At every 

end of line handles are added to resize and a separate handle to rotate the shape. The translation 

of shape is the same for all shapes. Drawing the polygon is same as line but when double clicked 

the last line is connected to the first line. Thus, forms a closed shape. Handles are added at every 

edge to resize and rotate the polygon. Arrow and Triangle are drawn with a default size when 

clicked on the drawing area. The handles can be use to resize and rotate these shapes. 

 

Shapes Attributes       

The shapes attributes such as pen color, width and styles. Brush color and fill styles can 

be select from the Home tab and set to the selected shape. 

 

Selecting or Deselecting the Shape 

The shapes can be selected by clicking the mouse on it. Multiple shapes can also be 

selected or deselected by holding the ctrl button on key board and click the mouse on the shapes. 

 

Cut, Copy and Paste  

  All three operations can be performed on single shape or on group of shapes. These 

operations can be selected from edit menu or from Home tab edit panel. 

 

File Operations 

All types of file operations can be done in OMSketch application. The shapes can be 

saved into png and bmp formats. The new option clears the drawing area before it clears it check 
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for the saved status of the scene. If the scene is not saved it directs to save option and then clears 

the scene. The user can select a group of shapes or a specific shape and save them or all the 

shapes on the scene can be saved. Png and Jpg file formats can be opened. The save as option 

saves the already saved shapes to a new file. 

 

Export and Import of Shapes 

Selected Shape will be exported in to OMNotebook cursor position. A new shape can be 

imported to the present scene in the OMSketch. 

 

Editing the shape from OMNotebook 

To edit a shape in OMNotebook, the cursor is placed at the shape and ctrl+e button 

pressed. This action imports the shape to OMSketch. 

 

 



 

 

 

 

 


